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Congratulations: 

You have just purchased a unique leading-edge product, part of a family of products pub­ 
lished by Paracamp in response to your needs. Milo is the first WYSIWYG math equation 
processor for the Mac. Milo allows you to solve mathematical equations, effortlessly graph the 
results and easily explain the results through its technical word processing capabilities. All 
this as if you were working on a normal piece of paper without having to worry about erasing. 
Plus,·all of these features come to you without ever having to learn a very time-consuming pro­ 
gràmming language. Why? Because there is none! 

Paracamp wants to bring out the best programs we can. We strive for uniqueness in both our 
developments and in the programs we publish. It is of extreme importance that we offer you 
something that will benefit your daily life. Milo is one such product. I know, for example, 
Milo would have made a fundamental difference to my own math experiences and to the 
results I received during my college math courses. 

In addition to Milo, Paracamp has already released Swivel 3D, the first of a new genre of 
graphics-based drawing and modeling packages, which for the first time brings mainframe 
capabilities to the Macintosh computers of today. In the near future, expect several essential 
packages for your engineering and scientific needs from Paracomp, Many of these will be 
complimentary to Milo and bring you closer to a complete technical solution. Look for a closer 
relationship between Milo and your favorite math and word processing programs in the near 
future. 
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At Paracamp we listen to our customers, your suggestions are very important to us as we do 
aggressively upgrade our products. Our support and technical teams will be happy to take 
any of your calls so don't hesitate. 

Many people have led to the success of Milo. I would like to thank Ron A vitzur for his 
commitment and for allowing us to make Milo a commercial reality. I also would like to thank 
Neville Campbell for his product management and Jonathan Perrow for his excellent writing 
of the users manual that should add immeasurably to your understanding of Milo. Finally, I 
would like to thank the entire Paracamp team for all their hard work. 

I believe Milo is be the electronic scratchpad of choice for anyone using mathematics. 

My best, 
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Bill Woodward 
November 1988 
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Introduction 
Milo is the first intelligent piece of paper for mathematics: a fast, easy to use, 
powerful and intuitive math processor for the Macintosh. Milo lets you enter, 
manipulate, simplify and graph mathematical equations and text in a completely 
what-you-see-is-what-you-get (WYSIWYG) manner unlike any math program 
available for the Mac. To use Milo, you must have an understanding of the 
Macintosh and also of mathematics. Just as a word processor does not "know" 
English, Milo does not "know" math. Milo will be most useful when you already 
know the steps that lead to solving your problem. If you supply the understand­ 
ing and can lead Milo through each step of a problem, it will keep track of the 
minus signs and factors of two and work through all the steps quickly. Milo lets 
you try out different ideas in the language of mathematics and provides instant 
visual results. 

What you ne·ed to use Milo 
Milo will run on any Apple Macintosh computer with 512 KBytes or more of 
memory and an internal double-sided disk drive. That is, it will run on a Mac 
512KE but not on a 128K or an old 512K machine with a single-sided drive that 
still has the 64K ROMs. If you have only 512 KBytes of memory, it will be diffi­ 
cult to work with large documents or to have very many documents open at 
once. Milo will run comfortably on a Macintosh Plus or SE, and, of course, on a 
Mac IL Under MultiFinder it will run under a 384K partition, but a larger parti­ 
tion is recommended, when working with large documents or multiple Milo 
files. 

About system software 
Milo will not work with System 4.0 or earlier. It requires System 4.1 or later. Due 
to space limitations, System 4.2 is included with Milo; it contains few fonts and 
desk accessories and does not contain the LaserWriter resources. 

The Milo application is in a file on the Milo distribution disk you have received. 
The disk is not copy protected. The next chapter explains how to copy the disk, if 
you are not sure of the procedure. Use the copy and put the original Milo disk in 
a safe place in case the copy is damaged. You should carefully read and under­ 
stand Paracamp' s licensing agreement before you proceed. 

About this user's guide 
This user's guide describes what Milo can do and shows you how to put the 
program to work. You should already be familiar with the Macintosh, at least the 
basics of pulling down menus, selecting, clicking and dragging with the mouse. 
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If you are new to the Mac, now is a good time to whip out a Macintosh manual 
and get up to speed before reading any more about Milo. 

This user's guide is divided into two sections, the Tutorial and Overview section 
and the Reference section. Chapters one through three constitute the Tutorial and 
Overview section, offering a "hands-on" approach to learning the program. 
Chapters four through nine make up the Reference section in which commands 
and other aspects of the program are explained in detail. 

This chapter covers what you will need to use Milo, and what you should expect 
to get out of the program and this user's guide. 

Tutorial Section 

Chapter 1, "Overview" lays the groundwork, giving you a general understanding 
of how Milo works and how to use it to write, simplify and solve simple equa­ 
tions. 

Chapter 2, "Getting Started" helps you get Milo up and running on your Macin­ 
tosh. 

Chapter 3, "Tutorials" offers an overview of the program through five tutorials 
that contain examples of Milo in action. The tutorials offer step-by-step instruc­ 
tions on how to use Milo to solve specific problems from graphing transcendental 
systems of equations to finding the area bounded by a curve. 

Reference Section 

Chapter 4, "Entering Expressions" provides a complete reference to the many and 
useful ways that mathematical expressions can be entered into Milo. 

Chapter 5, "Rewriting Expressions" explains all the ways that Milo manipulates 
and simplifies expressions you have already entered. 

Chapter 6, "Using Rules" documents the commands for customizing Milo's built­ 
in pattern matcher to simplify expressions. 

Chapter 7, "Graphing Expressions" shows you how to graph equations using 
Milo's powerful graphing interface. 

Chapter 8, "Other Features of Milo" demonstrates some of the options available in 
the program. 
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Chapter 9, "Tips and Techniques" lists many of the shortcuts and techniques that 
will help you use Milo efficiently and includes a quick-reference guide to Milo 
commands. 

Bulletin Board 
Paracomp, Inc. provides a bulletin board for registered owners of their products 
at (415) 882-0523. We encourage users to upload any documents they would like 
to make publicly available to demonstrate unique uses of their products. In the 
case of Milo, this is an excellent medium to build up large integral tables and 
other math tables. 

Also, the bulletin board can be used to ask questions and solve common prob­ 
lems. Bug reports and suggestions for future improvements may be made 
directly to Paracomp. 

Newsletter 
Registered users will receive a special Milo newsletter direct from Paracomp, Inc. 
to suggest new applications and answer common questions. 

Hotline 
For help solving problems and assistance with technical questions please call 
Paracomp Technical Support at (415) 543-3848 between 9:00 a.m. and 5:00 p.m. 
Western time. 

Notation and abbreviations 
To avoid confusion, the following special notation is used in certain places: 

@ A box drawn around a letter, number or other symbol is used to 
indicate keyboard input into Milo. The keys (jj), @ill and 
[ SM ft ] are followed by a dash and another boxed symbol like this: 
(jj) - @. This indicates that the command key should be held 
down while typing an "A." 

Bold To indicate noteworthy features of Milo that may be different from 
what you might expect. 

111 
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Keyboard input is indicated by the boxed symbols described above. In certain 
instances, this notation does not show the shift key being held down. For ex­ 
ample, if you are entering expressions from the keyboard, some mathematical op­ 
erators will appear differently in this mode than they do when you see them on 
the screen. For example, typing (ID [ sh;ft ]-(ID Œ) in Milo will produce 32. For 
clarity, the keyboard combination [ s M ft ]-(ID will be signified as Ô throughout 
this text. 

The disk that comes with this user's guide will be referred to as the Milo distribu­ 
tion disk. 

Special keys 
The following keys perform special functions in Milo: 

Key Notation Function 

Command ~ Used as a control key to alter the 
meaning of characters typed at 

@D 
the keyboard. 

Option Used in the same way as the 

~ 
command key 

Space Expands selected range of an 

EJ,E) 
expression. 

Left and Right Arrow Traverse the expression tree. 
Up and Down Arrow œ, m Increment or decrement 

Gill 
selected range. 

Tab Cycles the insertion point 
through the prompts in a 

[return] 
template. 

Return Creates a new line in an equation 
block, or a new row in a matrix, 
depending on the context. 

Enter [enter] Switches Milo from Text Block 

Q 
mode to Equation block mode. 

Comma Creates a new column in a 
matrix, adds a new parameter to 
a function or creates upper or 
lower index, depending on the 
context. 
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Period 

Backslash 

Hat 

o 
(S) 

ô 

Puts a dot over or creates a 
string "O." 
Defines strings for runtime 
macro definitions. 
Exponential Operator, short for 
[sMft ]-(ID 

Character differences 
Throughout the user's guide, the upper case letter "i" is referred to as: I, or (D 
The digit 1 will look like this: 1 
The capital letter O will look like this: O 
The digit zero, when typed from the keyboard will look like this: @ 
Expressions, subexpressions and equations 
This user's guide makes frequent reference to the words "expression," "subex­ 
pression" and "equation." Milo is a symbolic math program that manipulates 
mathematical expressions. Expressions can be as simple as the variable "x," or as 
complicated as your imagination and the program together will allow. Expres­ 
sions that include the equals sign operator are called equations and expressions 
that can be broken down into smaller expressions are said to be made up of 
subexpressions. 

The Milo distribution disk 
The Milo distribution disk is an SOOK-Byte double-sided disk that contains every­ 
thing you need to use Milo: 

• Milo: The application has an M icon 
• Backslash.ini: a Milo file containing macro definitions loaded at startup , 
• System Folder: folder containing System 6.0, Finder 6.0 
• Tutorials: folder containing tutorials for Milo 
• Tables of Formulas: folder containing tables of mathematical formulas 
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Chapter 1 Overview 

Chapter 1 Overview 
What this chapter contains 
Even if you consider yourself an experienced Macintosh user, you should read this 
chapter. For one thing, it is short. For another, it introduces the features of Milo. 
The discussion that follows explains how Milo works and outlines the two basic 
stages of the program: the input stage and the rewrite stage. 

• Inputting text 
• Inputting graphics 
• Inputting equations 
• Selecting expressions 
• Rewriting expressions 

Why you should read this chapter 
If you don't know what Milo can do, you won't be able to use it. 

Text, graphics and equations 
Milo is a powerful symbolic math processor. There are, however, three types of 
"blocks" that Milo can manipulate in a document: text, graphics and equations. 
Most of the power of Milo lies in the equation block where expressions are input, 
manipulated, and rewritten. Each block may contain only one type of input, but 
you can have as many blocks as you like in a document. This allows you to 
combine the different elements smoothly and easily in one document. 

If the insertion point is in an equation block, the menu bar will display menus for 
entering and manipulating equations. If the insertion point is in a text block, text­ 
editing menus will be displayed and for a graphics block the menus are altered 
accordingly. 

Inputting text 
In a text block, you can input text using Milo's built-in word processor. You can 
select, delete, cut, copy, paste, size and style in a standard Macintosh way. Since 
the text editor was designed primarily for writing comments between equations, 
Milo does not handle text blocks larger than 32,767 characters, or about 4,000 
words. This means you should not try to squeeze Moby Dick into a text block, but 
for most applications an average of over 4,000 words is more than enough. Text 
may be cut and pasted to and from Macintosh word processors and other text 
processing packages. 

Inputting graphics 
Milo graphs functions in a separate graphing window. From that window, you 
can paste a graph into the clipboard and from there directly into a document 
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window. The "Graph Expression" command in the Edit menu starts the graph­ 
ing procedure once an expression has been selected and lets you configure the 
horizontal and vertical coordinates of the graph. From a graphics block, typing 
[enter] will put the program in text block mode, and typing [return] will put 
the program in equation block mode. Any kind of graphics can be pasted into a 
graphics block of the document window from the Scrapbook. 

Inputting expressions 
Equation block mode is the most powerful and most used mode of Milo. In the 
input mode of an equation block, Milo should be thought of as a math processor, 
similar in function to a word processor or a food processor, except for math. 
There are two menus full of mathematical templates, a menu for diacritical 
markings, and a range of keyboard input options, that let you build highly 
complicated mathematical expressions in an equation block. Before you do 
anything mathematical with Milo, you have to input an expression. When you 
select a template or diacritical mark from the menu, Milo automatically inserts 
your selection into the equation block. Typically, one expression can be input per 
line, and each line extends horizontally up to 32,000 pixels, over 60 screen widths. 

From an equation block, typing the [enter] key will put the program in a text 
block, and typing the [return] key will create a new equation block. 

Selecting expressions 
In keeping with Charles Darwin, the selection process in Milo is quite natural once 
you get the hang of it. In order to input and rewrite an expression you will need to 
be comfortable with selecting expressions and parts of expressions. When you 
select an expression, you prepare it to be operated on by a rewrite rule, an 
operator, or Milo's Graph Expression command. A selected expression or subex­ 
pression is highlighted in white typeface with a black background. Y ou can select 
any expression or subexpression by either clicking with the mouse, using the 
space bar, or using the arrow keys. Milo will let you select only valid subexpres­ 
sions. 

Runtime definitions 
The Milo distribution disk includes a library of runtime definitions to make the 
input stage even easier. These are also referred to as standard macros, and they are 
found in a file called "Backslash.ini." Holding down the caps lock key when you 
boot the program tells Milo not to load the runtime library and speeds up the 
initial loading process. This means, however, that the runtime definitions will not 
be available. 

_ _j 
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Typing a backslash (S) followed by the name of a mathematical operation and 
then a space (!e) tells Milo to search through the runtime definitions library for 
a template corresponding to the name you entered. The space bar selects what 
you have typed and the backslash key tells Milo to check through the library. If it 
finds a match, Milo will insert the template in place of the word. For example, 
typing (S) (ID (ID~ (!e) tells Milo to search through the runtime library and 
insert the template: 

? 

~? 
?=? 

This offers an alternative to choosing the summation template from the Tem­ 
plates menu. 

Y ou can browse through the Backslash.ini file on the Milo distribution disk by 
using the Open command in the file menu while running Milo. 

Expression syntax in Milo 
All expressions in Milo are built from objects. Here are some examples of each 
kind of object in Milo: 

Atoms (Keyboard) 
Numbers 
Letters 
Strings 
Operators 

Diacritical Marks (Diac menu) 
Templates (Templates menu) 

3, 8, 10, 50 
a, b, c, a, b, g 
mass, meters_per_second 
+, -, I 
A - I B B B 
I I 

J?, f? d?, s in ? 

Strings as atoms 
Atoms can be numbers, letters or symbols typed in from the keyboard. When 
you type letters one after the other, they are considered by Milo to be individual 
atoms multiplied together. To create single variables longer than one letter, you 
use a string. Strings are invoked by typing the single quote key CJ or the 
backslash key (S) . 

- i I 
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At first, strings can look the same as several atoms multiplied together. To tell 
the difference, look at the space between the characters. Strings are tightly 
packed sequences of characters, while atoms are spaced farther apart. 

This is a string, considered as one atom: 

centimeter 
This is 10 atoms multiplied together: 

centimeter 
If you use Smart Quotes or any other program that converts straight quotes 
into curly quotes, it must be disabled in order for Milo to create strings in that 
manner. 

As you can see, mathematical objects in Milo can be atoms or templates. Atoms are 
the simplest objects from which Milo expressions are built and require no oper­ 
ands. Atoms can be numbers, letters or strings that fill in templates. Diacritical 
marks are used to modify atoms. Expressions are built hierarchically by recur­ 
sively applying templates to existing expressions. 

Here are some examples of expressions in Milo: 

3 9a1 a2-27a3-2a1 R=----- 
54 

sinx+cosx 
tan x 

-27 10 -l -3 -1 -3 6 626 x10 erg 2.997 xlo 5 cm = 6 17 xlo-17 ergs cm B ff)= . . 10 . 
Â,V 6.626 X 10-27 2.997 X 10 

1.38 X 10-l6 e -1 

Rewriting expressions 
In the rewrite stage of the program, Milo can be thought of as a mathematical 
engine with a WYSIWYG Macintosh interface. You can manipulate and simplify 
expressions. Any mathematically sensible subexpression can be selected and 
operated on independently of the rest of the expression. You can define and 

-· 

--1 

ì 
i 

- _) 

---,I 

---) 

_J 

___ J 



L 
I L 
I 

I L I 

I I 

L 
L 
L' 
L' 
L 
L 
L 
L 
L 
L 
L 
e 
L 
L 
L 
L' 
L 
L' 
e 
L 
e 
e 
L 

T I 
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apply your own rewrite rules that allow complex manipulation. Correctness­ 
preserving transformations can be applied to any part of an expression, often 
with just a click of the mouse. The rewrite phase of Milo was designed so you 
could spend more time thinking about the concepts and less time thinking about 
the details of a problem. 

Entering user-defined rewrite rules 
A prominent feature of Milo is its ability to perform pattern-matching operations. 
Using the Rules menu, you can store your own set of rewrite rules and apply 
them to any expression or subexpression in a Milo window. Sets of rules may be 
grouped together and stored as menu items in the Rules menu, and cannot be 
saved when quitting from Milo. Here is an example of a simple rule expression: 

a+b+a2+a3 

Y ou can create and apply a simple rewrite rule: 

a=a+l 

to achieve the following result: 

a +b +{a+ 1)2 +{a+ 1)3 + 1 
The rule may also be written as: a+- a+ 1 , which will be demonstrated later. 

Dummy variables, chosen from the Diac menu, are used as wild cards that take 
on the value of any expression during a substitution. Dummy variables are 
shown in boldface type in Milo. 

Printing 
To print a document window, select the print option from the File menu, just as 
you would expect. 

Getting started 
If you are an experienced Mac user, you might have the urge to experiment with 
Milo right away. Now is a good time. If you are feeling less confident, take the 
time to read the next two chapters. The next chapter shows you how to get Milo 
running on your Mac, and the following one leads you through five tutorials that 
demonstrate the steps described above and the power and flexibility of the 
program. 
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Chapter 2 Getting Started 
What this chapter contains 
• Macintosh editing tools 
• Milo editing tools 
• How to get Milo running on your machine 

Macintosh editing tools 
Take a moment to make sure you are familiar with editing on the Macintosh. 
Milo makes use of the basic editing tools built into the Macintosh for both text 
and symbol editing. The Macintosh editing tools that Milo makes available, 
including some modifications to the standard Macintosh commands, are listed 
here as a reference: 

Cut, Copy, Paste, Clear, Duplicate and Undo 
The following Macintosh commands help manipulate text blocks and equations 
in Milo and are found in the Edit menu: 

Cut 

Copy 

Paste 

Duplicate 
Clear 
Undo 

Chapter 2 Getting Started 

Removes a selected block of text or graph and places it in the 
Clipboard. 
Copies a selected block of text or graph to the Clipboard without 
removing it from the document where it resides. 
Inserts a block of text or graph from the Clipboard at a chosen 
insertion point. 
Duplicates a selected text or equation block. 
Clears the selection range 
Cancels the last command typed, and restores the document to its 
previous state. The Undo operation works in Equation Block 
mode only, not in Text block mode. Though there is no official 
Redo command, if you select Undo once and then select it again, 
you will have effectively performed a Redo. 

The Scrapbook 
The Scrapbook file and the Clipboard file help store and move blocks of text and 
graphics: 

Scrapbook (Apple menu) The Scrapbook is a desk accessory used to store and 
transport pictures and text. 

Menus in general 
Menus contain lists of choices. Each pull-down menu on the Mac contains a list 
of related functions. When a menu item is written in black it is said to be "se­ 
lectable," meaning that its function can be performed in the particular place you 
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are in the program. If a menu item is "grayed-out," it is not selectable, and inap­ 
propriate for the place you are in the program. Menu items that have keyboard 
equivalents have them listed on the right side of the menu. 

Menus in Milo 
Milo displays the standard Apple, File and Edit menus, and adds different menus 
depending on which mode (equation, text or graphics) the program is in. This 
section outlines the way menus are set up in Milo and describes briefly what they 
do. Chapters four, five and six provide in-depth information on each of the Milo 
menu commands. 

Text mode 
The menus for Text mode: 
Style Alters style and size of font 
Font Changes font families 

Equation mode 
Commands for entering expressions are contained in the following 
pull-down menus. 
Diac Diacritical marks like primes, dots, tildes and bars 
Templates The most common objects as well as the Calculus, Trig and More 

submenus: 

Commands for rewriting expressions are contained in the following 
pull-down menus: 
Simp A range of simplifying techniques 
Tfm A range of correctness preserving transformations 
Rules User-definable rewrite rules to simplify expressions 

Using the Option command in the Edit menu, the Calculus, Trig and More 
submenus may be listed as top-level menus and displayed in Milo's menu bar. 

When you insert a template from the Templates menu, the template you have 
chosen will appear on the screen with ? prompts in any and all the places that 
need to be filled in. 

Bringing up Milo 
If you haven't already done so, you should make a copy of the Milo distribution 
disk. Put the original Milo disk in a safe (but memorable) place. 

Copying the Milo disk 
Before you do anything else, lock the Milo distribution disk. This is accomplished 
by sliding up the black tab on the back of the disk to reveal a hole where the tab 
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was. When the disk is locked, it cannot be erased. There is no reason for you ever 
to unlock the disk since you only want to use it to make copies. 

Copying the disk using a Mac with one floppy disk drive 
• Turn on your Macintosh and insert the Milo distribution disk into the floppy 
drive. 

• When you see the disk icon appear on the screen, choose Eject from the File 
menu and remove the Milo disk. 

• Insert a blank formatted 3.5-inch disk into the drive. Refer to your Macintosh 
manual for instructions on formatting a disk if you are not sure how to do this. 
Name your blank disk "Milo Work Disk." 

• You should now see two icons on your desktop, one called Milo and one 
called Milo Work Disk. 

• Click on the Milo distribution disk, hold down the mouse button and drag its 
icon on top of the Milo Work Disk icon. When the Milo Work Disk icon turns 
black, release the mouse button. The Milo Work Disk will automatically eject 
from the drive and you will be asked to insert the disk called Milo. 

• Follow the instructions in the dialog box to swap disks. The more memory 
(RAM) you have installed in your machine, the fewer disk swaps will be 
needed to copy the disk. 

Copying the disk using a Mac with two floppy disk drives 
• Turn on your Macintosh and insert the Milo distribution disk into the internal 

floppy drive. If you have two internal floppy drives, insert the Milo distribu­ 
tion disk into the top drive. 

• When you see the disk icon appear on the screen, choose Eject from the File 
menu and remove the Milo distribution disk. 

• Insert a blank formatted 3.5-inch disk into the second drive, either the external 
floppy drive, or the bottom internal drive. Refer to your Macintosh manual for 
instructions on formatting a disk if you are not sure how to do this. Name 
your blank disk "Milo Work Disk." 

• Y ou should now see two icons on your desktop, one called Milo and one 
called Milo Work Disk. 

• Holding down the mouse button, drag the outline of the Milo distribution 
disk icon on top of the Milo Work Disk icon until the Milo Work Disk icon 
turns black. Release the mouse button. 

• The Milo Work Disk will eject and you will be asked to insert the Milo distri­ 
bution disk. 

• After you insert the Milo distribution disk, a dialog box will appear, asking if 
you want to completely replace the contents of the Milo Work Disk with the 
contents of the Milo distribution disk. Click OK. 

9 



Milo User's Guide 

---7 

10 

Copying the disk using a Mac with a hard disk 
• Boot your Macintosh from the hard disk as you normally would and open your 
hard disk if it is not already open. 

• Create a new folder on your hard disk by selecting New Folder from the File 
menu. Call the new folder "Milo Folder." Refer to your Macintosh manual for 
more information on how to do this if you are unsure. 

• Insert the Milo distribution disk into the 3.5-inch disk drive and double-click on 
the Milo distribution disk icon. Select the Milo Application, Tutorials, 
Backslash.ini and Tables of Formulas icons by dragging a box around them. 

• Holding down the mouse button, drag the outline of the selected files on top of 
the "Milo Folder" icon until the "Milo Folder" icon turns black. Release the 
mouse button. 

Remember to put the original Milo distribution disk in a safe place away from 
magnets and foul weather, and reboot your Macintosh. 

Love at first sight 
Open the Milo Folder you created. When first learning Milo, be sure the caps lock 
key is not engaged. Double-click on the Milo application with the M icon inside 
the folder. You have to wait a few seconds while the program is loaded into 
memory. The first screen you will see is this: 

• File Edit Templates Dine Simp Tfm Rules 
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The Untitled window with a ? prompt in the upper left corner is where you will 
build, manipulate and rewrite expressions as well as type text. Graphing expres­ 
sions takes place in another window. When you are ready to save the "Untitled" 
window, you can name it just about anything you like. 

Fasten your seatbelt, you are now ready to take off. The next chapter contains 
five tutorials that will help you work through some of the things you can do with 
Milo. 
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Chapter 3 Tutorials 

What this chapter contains 
Step-by-step examples of how to use Milo in the following areas: 
• Basic editing 
• Differentiating and integrating 
• User-defined rewrite rules 
• Strings and numbers 
• Graphing 

This chapter contains six tutorials demonstrating most of the basic features of 
Milo by presenting some math problems step by step. The Tutorials provide a 
feel for how to use Milo by example, without explaining the commands in too 
much detail. The reference chapters four through seven are reserved for a com­ 
plete explanation of all the Milo commands and their functions. 

How to use the tutorials 
To get the most from the tutorials provided in this user's guide, you should run 
the program and go through each step as it is outlined in the tutorials. It is a 
good idea to duplicate your work in the tutorials at every step. When you have 
completed a step, select the current expression and choose the Duplicate com­ 
mand from the Edit menu. This will allow you to look back at a trail of your 
work so you can see where things went wrong or right. 

On the Milo distribution disk is a folder containing Guided Tours that corre­ 
spond to these tutorials. You may, if you so choose, follow along in the guided 
tours. Just run Milo and open the first guided tour using the Open command 
in the File menu. 

Tutorial 1: Editing in Milo 
What this tutorial contains 
• Entering an expression 
• Keyboard equivalents 
• Inserting text 
• Building Expressions 
• Making a copy of the expression 
• Selecting the expression 
• Manipulating an expression 
• Solving the expression for a variable 
• Simplifying the expression 
• The Solve For command 

13 
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When you first boot the program, Milo expects the first thing you type to be an 
expression. The-available Milo menus File, Edit, Templates, Diac, Tfm and Rules, 
reflect the fact that the program is in equation block mode. 

Entering an expression 
You do not have to type an expression if you don't want, but let's insert the 
expression 32. Pull down the Templates menu and select the "Power" template. It 

should look like this: 

m? 
Replace the highlighted ? with the number 3 by typing the @) key on the key­ 
board to produce this: 

3~ 

Click on the remaining ? to highlight it: 

3'J 
and type the number Œ) to produce the result: 
32_ 

Congratulations! You have just entered an expression in Milo. 

To simplify this expression, first select it by pressing the space bar twice. Next, 
pull down the Simp menu and choose the Simplify command. This will rewrite 
2 3 as9. 

Keyboard equivalents 
The sequence described above can be made easier and faster if you use keyboard 
equivalents for many of the commands. Instead of pulling down the Templates 
menu and choosing the "Power" command, the same 32 expression could have 
been obtained by using the Ôkey, which is the keyboard equivalent of the Power 
command. Though this key is actually represented on the keyboard as [ shift ] - 
(ID, it is represented here as Ô for clarity. Typing @) Ô Œ) directly at the key­ 
board produces the same result, since typing the Ô key is exactly the same as 
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pulling down the Templates menu and selecting the Power command. The key­ 
board equivalent for the Simplify command is ~- @, so instead of pulling 
down the Simp menu and choosing Simplify, you could just type~-@. 

The keyboard equivalents for menu commands are displayed to the right of the 
command listing in the menu. See the Tips and Techniques chapter for a com­ 
plete explanation of some keyboard equivalents. 

Inputting text 
Let's switch gears to get a feel for Milo's text editing capabilities. Pull down the 
Edit menu and choose the Insert Text Block command. At any time, you can 
switch between text and equation mode, since the active document window is 
used to contain both text and expressions. Notice that in text mode, the prompt 
jumps down a line and changes from a "?" to a blinking "I ," and the menu bar 
changes to display the File, Edit, Style and Font menus. Go ahead and type some 
text like this: 

á File Edit Style Font 

ªº Milo Tutorial 0ê 
9 

This is a text block ~ 

·~·~·~·:·:·:·:·:·:·:·:·:·:·:J~U- - . - . - . - . - . - . - . - . - . - . - . - . - . - . - . - . - . - .i.:.·:: - . - . - . - . - . - . - . - . - . - . - . - . - . - .X. - . - . - . - . - . - . - . - . - . - . - . - 

In text mode, you can type text and use the menus to change the font or style of 
what you type. Experiment with typing and selecting text, as well ~s using the 
various menu commands. This is exactly the way you use the text mode to enter 
comments in a Milo document. 

You can comfortably type up to 32,767 characters of text per text block, about 
4,000 words. In version 1.0 of Milo, the Undo command in the Edit menu is not 
implemented in text block mode. 
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Now select everything you just typed in the text block and type in the words: 
"Editing In Milo." Unlike in equation block mode, selecting text and typing 
something new in text block mode deletes everything you had selected and 
replaces it with what you type. 

Now switch back to equation block mode by pulling down to the Edit menu and 
selecting the Insert Equation Block command. A faster way to switch from one 
mode to the other is to use the [enter] key. Try typing the [enter] key now. 
Notice that the prompt again jumps down a line and changes back to a?. 

á File Edit Templates ülac Simp Tfm Rules 
§0 Milo Tutorial t!J§ 

9 

Ed;ting in Milo 

i 

-~·:·:·:· · : -~·:·:· .. : · · :: : ·:·. ·:·:·:=:. · : . 

Experiment with jumping back and forth from one mode to another with the 
[ enter] key, but make sure to end up back in Equation mode with the ? prompt. 

Building expressions 
Let's take a look at how easy it is to build a more complicated expression, differen- 
tiate it, and graph it. 

First, make sure Milo is displaying a ? prompt, and then type: 

CD0ŒJ~~OOôŒJ~~~GCD0ŒJ~~OOôŒJ 
~ ~ ~ G (ID Œ) G Œ). This will produce the following expression: 

!x3+!x2+6x+8 
3 2 

-·1 
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Making a copy of the expression 
Suppose we want to make a copy of the expression we just entered. Try out 
Milo's Duplicate function by selecting the expression and choosing Duplicate 
from the Edit menu or by typing (jj)- @, its keyboard equivalent. Y ou now 
have a fresh copy of the expression to work with. Make a point of using the 
duplicate command often to leave a trail of your steps. 

Now let's take the derivative of the current equation with respect to "x." With 
the mouse, select the entire expression by clicking on the left side of the expres­ 
sion and dragging to the right so it looks like this: 

!x3+!x2+6x+8 
3 2 

Now type (jj)- Œ) to insert the Partial Derivative template to produce this: 

a~ Ox3+2+6x+s) 
Type an Œ) where you see the ? prompt to take the derivative with respect to the 
variable "x" and select the entire expression again. This time, type the Eval 
Derivative command (jj) - (ID and you should see: 

Mild 
Yet Another Expression 
Type [return] and let's learn more about Milo by building another expression: 

a __ b_+_d_a_4x 
16x 

¡ 
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At the? prompt in equation mode, type (fil (ID(!)@)@, to produce the nu­ 
merator of the fraction. Now, to divide the numerator by "16x", you have to select 
what you want the numerator to be and divide it by "16x." If you type the division 
operator (Z) without selecting the entire numerator, the last atom you typed will 
be set up as a numerator to a fraction and the expression will look like this: 

a ab+d- 
? 

Selecting the expression 
For the entire expression ab+da to be divided by "16x," you have to select the 
entire expression. Selecting the expression can be done in two ways. First experi­ 
ment by clicking with the mouse on one side of the expression and dragging 
toward the other. As you drag, notice the way the selected range jumps to include 
the next largest subexpression. 

--ì 
- _J 

• File Edit Templates Dine Simp Tfm Rules 
Untitled t!] 
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The alternative to using the mouse is to use the space bar. The space bar is a con­ 
venient way of selecting expressions and subexpressions because your fingers 
never have to leave the keyboard. 
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To select the expression you just typed, make sure it is not already selected and 
press the space bar three times. Just like dragging with the mouse, every time 
you press the space bar, the next largest subexpression is selected: 

Pressing the space bar once: ab + d!!'i 
Pressing it again: ab +mffl 
Pressing it again: ffl•Ü•I 
Milo will never let you select an invalid subexpression like "ab+." You may 
only select valid subexpressions. 

Now type the division operator (Z). Note that it is applied to the entire selected 
range, and Milo displays. 

ab+da 
? 

Type (D (ID Œ) and then§@) Œ). Notice that you do not have to select the 
entire left-hand side of the expression to have the equals sign apply itself ap­ 
propriately. 

You should now see an expression that looks like this: 

ab+da 4x 
16x 

produced from the following sequence of keystrokes: Œ) (ID G @ Œ) ~ ~ 
~ 0 CD (ID ŒJ G@ ŒJ 
Before moving on, experiment with selecting different parts of the above equa­ 
tion using both the mouse and the space bar until you begin to feel comfortable 
with the selection process. In the long run, this will save time and frustration. It 
is important to become proficient with selecting things to use the program effi­ 
ciently since almost all operations in Milo act on selected ranges. 

Manipulating the expression 
One of the most useful features of Milo is its ability to manipulate expressions 
quickly and easily. Let's experiment with this notion. Select the "ab" in the equa­ 
tion you just entered, pull down the Simp menu and select the "Move Term 
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Right" command. The numerator, which used to read "ab+da," should now read 
"da+ab." 

The Move Right and Move Left commands can be executed from the keyboard 
using the ~ - O combination for Move Right and the ~ - Q combination for 
Move Left. The most useful way to move terms around in an equation is with the 
mouse. Selecting a term in an expression, holding down the ~ key and clicking 
to the left of the term executes a Move Left command, and holding down the ~ 
key and clicking to the right of the selected term executes a Mov~ Right command. 
This is called "command clicking." 

Get a feel for these manipulations. Select the "ab" term in the numerator again, 
hold down the ~ key and click and release the mouse button directly to the right 
of the equation. You have just executed a Move Right command. The Move Left 
command is performed in the same way, just select the "ab" again and click to the 
left to move it back to its original place. Try this operation when just the "b" is 
selected and watch it change places in the product. 

____ ¡ 

Solving the expression for "a" 
Let's solve for "a" in our sample expression. To do this, we want to move the "a" 
out of the numerator and move the "16x" to the right side of the equation. 

Begin by selecting the left-most "a" in the numerator with the mouse. Command­ 
click to the left of the "a." Remember to click directly to the side of the "a," not 
above or below it. This will factor the "a" out of the numerator and leave the 
expression: 

a(b+d) 
16x 

4x 

Now select the "16x" from the denominator, command-click once to the right of it 
to move it out of the fraction, and again to move it to the right side of the equation. 
If you stop here, you get this: 

a{b+d) = (16x) 4X 
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Simplifying the expression 
But why stop now? Select the right side of the equation either by dragging over it 
with the mouse, or by selecting some part of it and pressing the space bar until 
the entire right side is selected. Pull down the Simp menu and choose the Sim­ 
plify command to simplify just the right-hand side to produce: 

a(b+d) =64x2 

Now solve for "a" by selecting the "b+d" subexpression, move it to the right, and 
simplify the new right-hand side. You should already be familiar with the way 
most operations (not the equals sign) affect only a selected range, and the possi­ 
bility of using the ~- Œ) keyboard equivalent for the Simplify command. Your 
equation should look like this: 

64x2 a=-- 
b+d 

Solving the expression for "d" 
Let's use the copy you just made to begin solving for "d." First select the denomi­ 
nator "b+d" and move it to the left side of the equation with either two com­ 
mand-clicks or ~ - Q twice to produce: 

a(b+d) =64x2 
L 
L 
L 
L 
(J 

L 

L 21 L 
L 

We now want to distribute the "a" into the parenthesis. There are two ways to do 
this. The first way is to select the whole left side of the equation, pull down the 
Simp menu and select the Distribute command. The second way is to select just 
the "a" and move it into the expression to its right by holding down both the~ 
and the @:e!) keys and clicking inside the parenthesis to the right of the "a." 
After the distribution has been performed the equation looks like this: 

ab+ad=64x2 
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Now move the "ab" term to the right side of the equation by selecting it and 
command-clicking on its right three times. Notice that it acquires a minus sign in 
the process: 

ad=64x2--ab 

·-ì 
I 

Isolate the "d" by selecting the "a" still on the left side of the equation and com­ 
mand-clicking it into place on the right. Notice how it is inverted across the equals 
sign: 

a=~(64x2-ab) 

The Solve For command 
An easier way to solve for "d" is to use the Solve For command in the Simp menu. 
The Solve For command only operates on a selected range, but since there is only 
one "d" in the above expression, Milo will isolate it. If you were to select one of 
the "s's" in the above equation and Solve For it, Milo would move the unse­ 
lected II a" to the other side of the equation along with the other unselected 
terms. 

Saving, closing and quitting Milo 
Before moving on to more advanced features in the next tutorial, it is a good time 
to learn how to save your work and quit the program. This is done in a standard 
Macintosh way. 

Pull down the File menu and choose the Save command. You will be presented 
with a dialog box asking for a name for the file, and you can name it "My Tuto­ 
rial," or virtually anything you like. Click on the save button in the dialog box and 
then choose Quit from the File menu to return to the Finder. 

You will see your new file called My Tutorial in the same folder as the Milo 
application. If you want to open the file in Milo, just double-click on the My 
Tutorial icon. 



L 
L 
L 
e 2 
L 
L 
e 
L 
L 
L 
L 
L 
L 
e 
,. 
\i..- 

L 
L 
L 
L 
L 
, 1 

L... 

L 
L 
L 
e 
L· 

Chapter 3 Tutorials 

Tutorial 2 Differentiating and Integrating 

What this tutorial contains 
• Differentiating rational functions 
• Differentiating trig expressions 
• Finding the area bounded by a curve using polynomial integration 

This tutorial goes over the steps of how to differentiate expressions in Milo. 
Polynomial integration is illustrated here. Any integration methods more compli­ 
cated than polynomial integration are left for the next tutorial that outlines how 
to use Milo's pattern matcher, and the reference chapters. Some of the examples 
are graphed to illustrate the how graphs are useful in particular applications. 

Before you start this tutorial make sure you are running Milo and have a new 
"Untitled" window on the screen. 

If you are not already running Milo, double-dick on its icon in the folder you 
created. You should see a new window with the ? prompt highlighted. 

If you are running Milo already, type ~ - (ID to create a new "Untitled" 
window. 

Differentiating a rational function 
Let's differentiate the following expression: 

x3+2X+l 
x2+3 

First we have to input it into Milo. Start by typing Œ) Ô @) to get X 3. Press the 
space bar twice to select what you just typed and enter G œ Œ) G (D. 

Now select everything using either the mouse or the space bar. Type a (Z) to 
create a fraction, and then type in the denominator: Œ) ô œ ~ ~ G rn. 
You should be getting a feeling for how Milo operates on a selected range. 

Now is another good time to make a copy of the expression using the Duplicate 
command in the Edit menu. Make sure you first select the expression. 

23 
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Select the duplicate expression with the mouse and insert the Partial Derivative 
template by typing (jj)- Œ). This also can be done through the Calculus sub­ 
menu under the Templates menu as well. You should now have an expression that 
looks like this: 

1._{x3 +2x + 1) 
ail x2+3 J 
Notice that the insertion point in the derivative template is set to let you specify 
what to take the derivative with respect to. In this example, type an "x." 

Now we want to evaluate the derivative, but first, a useful hint. Select the whole 
derivative expression, use the Copy command in the Edit menu to copy it to the 
clipboard, type an§ and paste the expression back. You have created an equa­ 
tion and you can now solve the right side while leaving the left side untouched: 

~{~
3 
+2x + 1)=~{~3 +2x + ~1 axl x2+3 J axl x2+3 J 

To evaluate the derivative, simply select everything to the right of the equal sign 
and type (jj)- (ID. This is the keyboard equivalent of the Eval Derivatives com­ 
mand under t~e Simplify menu. Y ou will see: 

~x2 +2) ~2+3)-2x ~3 +2x + ~ 

~2+3)2 

This is the solution, but if you don't like the way it looks, you can simplify all or 
part of it using the Multiply Out command in the Simplify menu. Select the 
numerator and type (jj) - (wJ (Multiply Out) to produce the better-looking ex­ 
pression: 

___ ) 



e 
e 
L 
L 
e 
ci 
L 
L 
L 
L 
L 
e 
L 
L 
e 
L' 
L 
L 
L 
L 
L 
e 
e· 
L 
L 
L' 

Chapter 3 Tutorials 

x4 +7x2-2x +6 

(x2+3)2 
If you feel so inclined, you can simplify the denominator in the same way. 

Differentiating a trigonometric expression 
Let's differentiate 

cos 2(2x) +sin (3x) 
Try typing it in on your own. If you get stuck, here is the series of keystrokes that 

will produce the expression: (£) (ID (ID@) Ô Œ) ~ Œ) Œ)@J@J@J 
@)@) G (ID CD (ID rn Œ). Notice how the tab key moves the insertion 
point to the next prompt. The expression should look like the one above. 

Select the expression and insert the Partial Derivative template using either the 
menu or the ~- (Ï) keyboard equivalent. Type an Œ) to take the derivative 
with respect to "x." The expression should now look like this: 

:Jas 2(2x) +si n (3x)) 
To evaluate the derivative, first select the entire expression by pressing the space 
bar until it is fully selected, then type ~ - (ID or pull down the Simplify menu 
and choose the Eval Derivatives command to produce: 

-4sin (2x) cos (2x) +3cos (3x) 
Finding the area bounded by a curve 
Let's find the area bounded by the curve: X 3 + 6 X 2 + 8 X and the "x" axis. The 
way to do this is to graph the expression first, find where the curve crosses the 
"x" axis, and evaluate a definite integral. 

First, enter the expression into Milo- Œ) (A) r-i'I @)@)@)@) 0 (ID Œ). . X LJ ~ @)@) G (ID Œ) ô Œ)@) 
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Now graph the expression by selecting it and typing ~-(ID. In the graphing 
dialog box, set the domain to go from O to 6, then click OK. Do not set any values ~ 
for the "x" and "y" axes, and leave the number of points set to 50. Here is what the 
graph should look like: 

Graph 0§ 

50. 

30. 

10. 

-10. 

From the graph, it is easy to tell that the curve crosses the "x" axis at points x=Û, 
x=2 and x=4. 

So the area of the portion of the curve lying above the "x" axis is given by: 
2 

f x3-6x2+8xdx 
o 
and the area of the portion of the curve lying below the "x" axis is 
4 

J-(x3-6x2+8x)œ< 
2 

The total area, then, is the sum of these two integrals: 

2 4 

f x3-6x2+8xœ<+ J-(x3-6x2+8x)œ< 
O 2 

__ _j 



~ 

C 
e 
L 
L 
e· 
e· 
L 
L 
e 
~ 

L 
L 
L 
e 
C' 
e 
L 
e 
L 
e· 
e 
L 
e 
L 
L 

Chapter 3 Tutorials 

To build this new expression, apply the Definite Integral operator to the existing 
x3-6x2+8x byselectingtheexpressionand typing@!}(sMft )-QJ. Use 
the tab key to cycle through the ? prompts and fill them in accordingly. With the 
space bar, select the entire expression, type ß, and enter the second integral. 
Instead of having to type it in again, you can copy the first integral, paste it after 
the plus sign, and make changes to it. To place parenthesis around an expression, 
select it, and type a left parentheses. To get the negation operator, type the minus 

key:ß. 

When the expression on your screen matches the one above, select it, and choose 
the Eval Integrals command from the Simp menu (or use ~- O]) to produce: 

2 4 f x3 -6x2 + 8x ctxL =O+ f-x3 +6x2-8x ctxL =2 
Apply the Eval Integrals command four more times until no integrals are left in 
the expression and it looks like this: 

x4 
--2x3+4x2 
4 

2 

X =O 

4 
X 3 2 +--+2x -4x 
4 

4 

X =2 

Select everything to the left of the second plus sign: 

x4 3 2 
--2x +4x 
4 x =O 

4 
X 3 2 +--+2x -4x 
4 

4 

X =2 

and type ~ - ŒJ (Evaluate in the Simp menu). This will produce 

~ 
) 

.4 
4 4 - 4 

X 3 2 X 3 2 X 3 2 --2x +4x ---2x +4x +--+2x -4x 
4 X =2 4 X =0 4 lx =2 
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If you type ~ - 0 (Eval Substitutions in the Simp menu) you will be left with: 

4 
4 

( ~ X 3 2 \4-0J +--+2x -4x 
4 1x =2 

Repeat the process, this time selecting everything to the right of the first plus sign 
like this: 

(4-0) + 
4 

4 
X 3 2 --+2x -4x 
4 X =2 

to get: 

(4-o) + (o--4) 
Select the above expression and type ~ - Œ) (Simplify in the Simp menu) to 
get 8. So now we know the area between the curve and the "x" axis is 8. 

~) 
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Tutorial 3: Using Milo's Pattern Matcher 

What this tutorial contains 
• Getting the idea 
• Using the Rule Tables provided on disk 
• Using dummy variables 
• U sing a rule set 
• The Create Menu Item command 

Before you start this tutorial, make sure you have a new "Untitled" window on 
the screen. This can be invoked using the New command in the File menu when 
running Milo. 

Getting the idea 
Milo's built-in pattern matcher allows you to rewrite expressions using user­ 
defined rules. Milo does not know how to integrate automatically anything but 
polynomials. To integrate, for example, a trig function, you have to use Milo's 
pattern matcher. 

This first example is trivial, but it illustrates the basic concept of using the pattern 
matcher. 

Select the Indefinite Integral template from the Calculus submenu of the Tem­ 

plates menu. Type (ID (O (ID Œ) and then~ to tab to the next? prompt. 
Type an "x" to integrate with respect to "x." 

Try to evaluate JS in X dx with the Eval Integrals command in the Simp menu. 
Remember to select it first, and notice that absolutely nothing happens. But if 
you know that JS in X dx= -COS X, you can input that as a rule and Milo will 
be able to perform the integration. 

Building a rule is just like building an expression except you use the assignment 
arrow(+-) interchangeably with the equal sign(=). To build a rule that translates 

JS in X dx into -COS X, select J sin X dx , type OJ and then type 
ß (f) @) (ID Œ). The colon key shows up on the screen as the assignment 
operator. 

"I 
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To enter this rule into Milo's pattern matcher, first select the desired rule with the 
mouse or the space bar, pull down the Rules menu and select the Enter Rule 
command. 

fsin xdx=-cos x . 
Ill! 

Rpply Rule 
Create Menu Item ... 

~ 

To apply the new rule, select any occurrence off Sin X dx, pull down the Rules 
menu and choose the Apply Rule command. Milo will rewrite f Sin X dx 
as -COS X. 

This is a trivial example of how to use the pattern matcher and it is admittedly 
easier in this case to rewrite f S in X dx by deleting it and replacing it with 
-COS X. But for larger, more complex expressions, the power of the pattern 
matcher is invaluable. 

Using the Rule Tables provided on disk 
Instead of having to build a rule every time you need one, The Milo distribution 
disk provides many files of pre-packaged rules. A complete list of the files is 
included in the reference chapter on rules later in this user's guide. Suppose we 
create the integral: 

Iª -(:t yl dy 
o 

Here are the keystrokes used to create the above expression: 

@ill - [ s M ft ] -(D Œ) Ô [)@D-(H)@D- ~@@ 0 Œ) 
[shift]- m@@@@(:)Œ)@@~-G@ŒJ(:)Œ) 
~ŒJ~OO~@D-[shift ]-(ID 

I 
I ~ 

___) 

-7 

,~ 
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To rewrite this definite integral pull down the File menu, choose the Open com­ 
mand. Select the Milo Folder and you should see a screen that looks like this: 

.... Edit Templates Dine Simp Tfm Rules 

lô Tables of Formulas I 

Cl SI Physical Constants 
[l Template List 
Cl Trig Identities 
Cl Units Ratchet 

E:::J junathan 

[ l:j(~(t 

[ Dril•<~ 

[ Open ] 

[ Cnncel ] 

Open the folder called Tables of Formulas. Find the file called Integrals-Definite 
and open it. 

When the file appears on your screen, scroll through it until you find the section 
called "Some Definite Integrals with the Exponential Function." Select the first 
rule that will rewrite the integral. It looks like this: 

feo -a 2 X 2 d J 1C e X=- 
0 2a 

With the above rule selected pull down the Rule menu, choose the Enter Rule 
command. You may now close the Integral Table file. Note that you do not need to 
copy the rule into your working Milo document in order to enter it. Now select the 

expression and type~ -Œ) (the keyboard equivalent of the Apply Rule com­ 
mand). See how Milo has rewritten the integral using the rule you entered from 
the Integral Table file: 

Jn 
2(;;) 
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The expression 

sin (e+e) ~ 

can be rewritten using a rule in the file called Trig Identities. Using the Open 
command in the File menu, open that file and find the rule 

sin (A +B) =sin A cos B +sin B cos A 

Enter this as a rule using the ~- (I)keyboard equivalent for the Enter Rule 
command. Back in the Milo window, select the Sin (e+ e) expression and 
apply the new rule to get: 

2sinecose 

Using dummy variables 
In the previous example, notice how the variables in the rule are boldface. 
Boldface variables in Milo are called "dummy variables" and are made to take on 

the value of any expression. Dummy variables are inserted by typing (jj) - 
@ill- @), or through the Diac menu. 

Here is an example of using dummy variables to recursively subtract the deriva­ 
tive of an expression from the expression. This generates a class of related ex­ 
pressions using a recursion relation. We will start by typing[) ô G CT) ô œ 
(!E) (!E) 0 Œ). This will build the following expression: 

t2 

e 2 

Then, using dummy variables to represent the function we want to differentiate, 
we create the rule to subtract the derivative from the expression times the 
variable "t:" 

at f +I t -- at 
The rule is created by typing (ËJ and making it into a dummy variable by typing 
~ - @ill-@). Next type a colon, (D to insert the assignment template and 

__J 

·---., 
I 

__ _j 
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insert another dummy variable f to the right of the assignment template in 
exactly the same way as the first. Then type (f) as a variable, followed by a 
minus sign: (:). Do not make "t" a dummy variable. 

Now insert the Partial Derivative template by typing~- (f) and insert the 
dummy variable and the variable "t" as follows: 

at f --f t -- at 
All that remains is to enter the rule and apply it. To enter the rule, select it and 
type ~ - OJ. Then select the expression 

t2 

e 2 

and type ~ - Œ) to apply the rule once. This will produce: 

t2 t2 -- a -­ 
te 2 --e 2 at 
Before applying the rule again, it will help to simplify the expression a bit. With 
this new expression still selected, type ~ - (ID to evaluate the derivative, and 
then~ - ~ to multiply out the terms of the expression. This will leave 

t2 

2t e 2 

You can apply the rule as many times as you like, repeating the three commands 
in order: ~ - Œ), ~ - (ID,~ - ~. When you decide to stop, you may 
factor the 

t2 

e 2 

term out of the expression by selecting it and typing~ - Œ). Use the Simplify 
command to clean up the result. 

"I 
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Applying the rule six times, factoring and then simplifying produces this expres­ 
sion: 

t2 

e 2 (64t6-480t4 +not2-120) 

Using a rule set 
In the Tables of Formulas folder on the Milo distribution disk, you will find a file 
called Units Ratchet. This file contains many rules related to unit conversion. A 
complete list of all available files in the Tables of Formulas folder is included in 
the reference chapter on Rules. Open the Units Ratchet file using the Open com­ 
mand in the File menu. The first equation block of the file contains a list of equa­ 
tions that express the relationship between seconds, minutes, hours, days and 
years. The equation block looks like this: 

s=3.1688x10-8yr yr=365.242d d=24hr hr=60min min=60s 

This is called a ratchet because it cycles through the units, representing the same 
time frame in terms of seconds, minutes, hours, days and years. 

Select the entire line just as it is selected above, and enter all the rules at once by 
typing~- (D (Enter Rule in the Rules menu). Now type Œ) CJ Œ)@ 
(!el (!el. That stands for "two years." 

Apply the rule set by typing~ - Œ) , and then Number Crunch by typing 
~ - Œ) to produce: 

73 O .484d 
Apply the rule again and number crunch: 

1 .7 5 31 6 x 10 4 hr 
And the same again: 

1 .O 51 9 x 10 6 Mi n 
And again: 

6.3114x107S 
If you apply the rule set one more time ( ~ - Œ) ), you will cycle back to "2yr." 

~ 
~ 
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The Create Menu Item command: using rules as templates 
Rules can be created and stored as menu items using the Create Menu Item 
command in the Rules menu. One use for this feature is to create and store tem­ 
plates. 

Build the rule a+- a2, enter it either by using the Enter Rule command in the 
Rules menu or by typing ~ - OJ , and choose the Create Menu Item command 
from the Rules menu. Remember that the (D key produces the assignment 
operator. The Create Menu Item command brings up this dialog box: 

Type the name for this menu item 

USER ITEM A /3 

[ Concei ] 

Click OK to accept the default name for the rule, or if you like, you may change it 
to any decent name that fits. 

Try applying the rule to this expression: a3 + a2 +a+ l. First select the expres­ 
sion, then pull down the Rules menu and choose USER ITEM A. Note the way 
Milo applies the rule and automatically multiplies the exponents a6 + a4 + a2 + 1 
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Tutorial 4 Strings & Numbers 
What this tutorial contains 
• Strings: variables longer than one character 
• Scientific notation 
• Number crunching 

This tutorial demonstrates how to harness more of the power of Milo. Make sure 
you have the program running on your Mac, with a new "Untitled" window 
open to begin. 

Strings: Variables longer than one character 
It is possible in Milo to use variable names that are longer than one character. 
This is accomplished with the single quote key CJ or the backslash key (SJ. 
If you type a single quote followed by several characters, you define a multiple 
character variable. 

If you are using a program like Smart Quotes that intercepts the single quote 
key and replaces it with a curly quote, disable it before proceeding. 

Now in an equation block type a CJ and note that two double quotes: "" appear 
on the screen with the insertion prompt between the two quotes. Continue by 
typing Œ) (D Œ) [) CT) (D (ç) (:) [) Œ) [)@@) Œ) and then press the 
space bar~- Note the use of the underscore key to denote a space between 
words. You have just created a string called "Kinetic_Energy" that will be treated 
as a single atom. 

When you type the first character of the string, a single quote appears just in 
front of it to let you know it is a string and not an atom. Strings longer than one 
character are not marked by a single quote, but can be distinguished from several 
atoms multiplied together because the characters in a string are more tightly 
packed than individual atoms. 

Select the string you just typed and try G (D (Z) Œ) ~ ~ CJ (BJ @ (ID (ID 
~ CJ Œ)[) (g@) (ç) (D CT) Œ) ~{:) Œ) You should see: 

Kinetic_Energy =i mass velocity2 
37 
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With the mouse, select this portion of the expression: 

Ki net i c_Energy = 
2 
mass velocity2 

and type an open parenthesis to produce: 

Kinetic_Energy =~(mass velocity2) 

Substitutions 
Let's substitute the string "kilogram" for mass and "meters/second" for velocity. 
Select this part of the equation 

Kl I E 1 Inet1c_ nergy =2 (mass velocity
2
) 

and type the command for the substitution template, Œe!J - CS), to produce 

Ki net i c_Energy =!(mass velocity 2) 
2 I?=? 

Now, remembering to use the single quote key to build a string, type the string 
"mass" at the first? prompt. Use the tab key to jump to the remaining? prompt 
and type the string "kilogram." Select this part of the expression 

Kl I E 1 inetIc_ nergy =2 (mass velocity 2) - kilog.r am 
mass - 

and use the~ - CS) (or choose the Eval substitution command from the Simp 
menu) to perform the substitution to make the expression look like this: 

Kinetic_Energy =~(kilogram velocity2) 

-- --7 
J 
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L..... 

We can substitute "meters/second" for velocity in the same way. Select every­ 
thing inside the parenthesis, including the parenthesis themselves. Insert the 
Substitution template from the Templates menu and fill in the prompts by typing 
a CJ and then the word "velocity" and then another CJ followed by 

(ô) ŒJ CT) ŒJ@(ID ~ 0 CJ (ID ŒJ @. Now select the appropriate subex­ 
pression so the equation looks like this: 

Kl • E 1 1 net I e_ nergy = (kilogram velocity2) 
velocity = meters 

second 

And evaluate the substitution to produce: 

. . lrkilogram meter2) K1net1c_Energy=- 
2 2 second 

Scientific Notation 
Numbers in Milo may be displayed in scientific notation. Make sure you are in 
an equation block and type the following sequence of keystrokes at the ? prompt: 
(ID Q@Œ) [ sMft ]-ŒJŒJ @). This will produce: 

6.02 x1023 

Only the "6.02" is part of a string. You can adjust the range of numbers displayed 
automatically by selecting the Options command in the Edit men (see chapter on 
Other Features of Milo). 

Number Crunching 
Enter the expression 

. 7t 
Sin - 

3 , 

select it and type ~ - Œ) to number crunch it. The atom 7t may be entered by 
typing @ill - Œ) or (SJ Œ) (D . Any expression that can be evaluated into a 
number can be operated on by the Number Crunch command. 
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Enter the keystrokes i[) Œ) G (D@)@)@) @) Ô (D 00 to build 
I 

the expression 

{x-1)10 

7 _J 

Note you do not havie to type a closing parenthesis since Milo creates both when 
you type the [) key. Select the expression and apply the Partial Derivative tem­ 
plate from the Calculus submenu of the Templates menu: 

~(x-1)10 ax 
Now select the entirJ expression and evaluate the derivative using the Eval 
Derivatives command in the Simp menu to create the expression: 

10{x-1)9 

For an added thrill, select the above expression and use the Multiply Out 
command in the Simp menu or type its keyboard equivalent ~ - (Y?) to expand it. 

Select this new long expression and apply the Substitution template from the 
Templates menu. Substitute "e" for "x," and evaluate the substitution a~ in the ex­ 
ample above to produce: 

1ox9-90x8+360xg-840x6+1260x5-1260x4+840x3-360x2+90x-10 

Finally, select the re~ult and Number Crunch it using (jj)- Œ). Since "e" is evalu­ 
ated as 2.71828 (you can set the number of decimal places using the Options 
command in the Edit menu), everything in the expression could be converted to 
floating point numbers and "crunched" to 1305.72. 
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Tutorial 5 Graphing Expressions 

What this tutorial contains 
This tutorial demonstrates the graphing features available in Milo. These include: 

• Graphing functions of one variable 
• Graphing a trigonometric expression 
• Zooming in on a graph 
• Overlaying graphs 
• Graphing a parameterized curve 

Before starting, make sure you are running Milo and have a new "Untitled" 
window on the screen. 

Graphing a function of one variable 
To graph the expression S in e - x 

2
, first input it into Milo by typing 

(ID (O (ID ŒJ Ô (:) Œ) Ô Œ) , select the expression, and choose the Graph Ex­ 
~ssion command under the Edit menu. This can also be invoked by typing 
~ - (ID. Y ou will be faced with a dialog box that looks like this: 

Title: 

H Label: 

Y Label: 

H RHis: I I to I I 
Y aals: I I to I I 
Domain:! 1 I to j 1. I 

Number of Points: I so I 
( Dk ) ( Cancel ) 

41 
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. -x2 
Suppose you want to graph SI n e from -3 to 3. You need not fill in all the 
values requested by the dialog box because Milo will pick reasonable values for 
the limits for "x" and "y" and the number of points to plot, if the boxes are left 
blank. Do supply the domain of the independent variable (in this case "x") and 
have it run from -3 to 3. Before you click OK, check to make sure the dialog box 
looks like this: 

Title: 

H Label: 

Y Label: 

H RHis: I I to I J 

Y aais: I J to I J 

Domain:1-3 j to I 3 J 

Number of Points: J so J 

[ Ok J [ Cancel ] 

When you click OK, Milo sets off to graph the 50 points. Each point is displayed as 
a number in the upper left corner of the screen as it is calculated. This is the way 
the completed graph should look on the screen: 

-\ 

__ J 

___ J 

--l 

--ì 
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êO Graph 0§ 

-3. -1. 1. 3. 

Graphing a trigonometric expression 
Using an example from the previous tutorial on differentiating and integrating, 
let's say we want to graph -4s in (2x) COS (2x) + 3 COS (3x). This, too, is 
a graph of a function of one variable. Just select the entire expression with the 
mouse and type~- (ID, or if you are die-hard menu puller, choose the ~raph 
Expression command from the Edit menu, which will bring up the graphing 
dialog box. 

If you have created graphs already during this session, the dialog box will 
contain the parameters from the last graph Milo drew. Delete them (you can 
cycle through the boxes with the ~ key) and leave the boxes blank. Do not 
put 00 in any of the boxes, just leave them blank. 

In the dialog box, we will set the domain parameter to go from O to 20. All the 
other parameters should be blank. The domain parameter tells Milo what num­ 
bers to use as input and is always the same as the value of "x." The parameters 
shown in the graphing dialog box are explained in the reference chapter on 
graphing. For now, type a 00 in the first Domain field, then use the ~ key to 
jump to the "To" box in the "Domain" section and set it to 20. Type a [return] or 
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click OK to produce this graph: 

Graph 

s. 

3. 

1. 

-1. 

-3. 

-s. 

--) 

Zooming in on a graph 
Let's zoom in on part of this graph to get a closer look at a maximum point. There 
are two ways to zoom in on a graph. 

The first way is to once again choose the Graph Expression command from the 
Edit menu or type ~-@ and set the "x" and "y'; values manually to effectively 
zoom in on a portion of the graph. This is the long way. 

The second and far easier way is with the mouse, to drag a box around the area 
you want to magnify and let go of the mouse button. Milo will automatically 
redraw the boxed-in portion of the graph. 

With the mouse, select one of the maximum points in the graph above by clicking 
in the upper left corner and dragging to the lower right: 

'-- } 
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Graph 

5. 

3. 

1. 

-1. 

-3. 

-5. 

When you let go of the mouse, the graphing dialog box appears with altered 
values in most of the parameter boxes. These are the new coordinates for the 
graph. Click OK and a new graph will be created showing the selected portion of 
the original graph: 

Graph 

5.4 

5. 

4.6 

4.2 

9.8 10.2 11. 11.4 11.8 

Try zooming in again on the new graph to get an even more accurate measure­ 
ment. If you like, you can paste this graph into your Milo document using the 
clipboard. The graph may be resized by clicking in the bottom right corner of the 
graphing window, though there is no resizing icon present. Once resized, the 
graph may easily be pasted into a Milo document. 
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Overlaying graphs 
Suppose you want to graph two expressions in the same plot to find out where 

cosxsinx . 
they intersect. Let's take the trig functions ----- and S I n X . 

tan x 

Build the first expression by typing (çJ (ID (ID Œ) ~ ~ (ID (D Œ) Œ) 
~ ~ ~ (Z) CT) Œ) Œ) Œ). Now type (return] and build the second expres- 
sion by typing Œ) (D Œ) Œ). You should have two expressions on two separate 
lines. 

Select the top expression and, with the ~ key pressed, drag down to the 
second expression to select both lines. Note that there is only one variable, "x," in 
both expressions. Now type ~-(ID to graph them both at once. 

Configure the graphing dialog box as follows, then click OK. 

_) 

1 

Title: 

H Label: 

Y Label: 

H RHis: I j to I j 

Y oHis: I j to I I 
Domain:! O j to I 10 j 

Number of Points: ! so j 

[ Ok ] [ Concei ] 
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Milo will respond with the following graph: 

Graph 

1. 

0.6 

0.2 

-0.2 

-0.6 

-1. 

You can zoom in on any area of the graph as discussed above, and determine the 
points of intersection 

Graphing a parameterized curve 
This example shows how to graph a circle and paste it into a Milo document. 

Type the expression (ID (D (ID Œ). Now type a GJ, and then ß) (ID (ID Œ). 
The semicolon operator lets you create more than one expression per line. 
Whenever you try to graph two expressions that are on the same line, Milo 
assumes you want a parameterized curve, assigning one function to "x" and the 
other to "y." 

With the mouse, select both expressions and type (jj) - @. Since we are graph­ 

ing a circle, choose a domain that goes from O to 6.5 (approximately 21t), and 
click OK. 
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You have produced a circle: 

§0 6rnph 

_J 

Though there is no visible resizing box at the bottom of this window, you can 
resize the graphing window by clicking in the lower right corner of the window 
and dragging it. Shrink the window until it is about two inches square. Type 
~- © (or choose the Copy command from the Edit menu) to copy the graph to 
the clipboard. 

Bring the Untitled Milo window to the foreground and paste the graph in at the 
end (use~ - Œ) or the Paste command in the Edit menu). It's that simple. 

Another parameterized curve 
Just for practice and partly for aesthetic reasons, example of a graph. 

Enter the following two expressions and separate them in the same equation block 
by typing a semicolon. 

logtsint log t cos t 
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Select them both by clicking and dragging and use~ - @to bring up the 
graphing dialog box. Set up the dialog box so it looks like this: 

Title: 

H Label: 

Y Label: 

H RHis: I I to I I 
Y aals: I I to I I 
Domain: I O. 1 I to I 1 8 I 

Number of Points: I 1 DO I 
( Ok ~J [ Cancel ] 

You may have to delete some fields and leave them blank. Notice that the 
domain parameter is set to go between 0.1 and 18. 

6roph 

3. 

3. 
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Chapter 4 Input Reference 

What this chapter contains 
Inputting expressions in Milo 

• Atoms 
• Polynomials 
• Unary operators 
• N-ary operators 
• Vectors, matrices, superscripts and subscripts 
• Calculus templates 

This chapter describes in detail every Milo command relating to the input of 
mathematical information. Each entry in the chapter describes a Milo command, 
provides standard macro syntax and information about how to use the com­ 
mand. 

The format of this chapter 
Each input command in this chapter is listed as it appears in Milo's menus. 
Relevant information such as keyboard equivalents and macros, are listed 
directly below the command name. The location of the command in the menus is 
shown using the greater-than symbol > to denote submenus and finally to point 
to the command name. This is followed by a complete description of the com­ 
mand. 

Milo's ability to graph expressions is not discussed in this chapter, but reserved 
for the reference chapter on graphing. 

Atoms 
The simplest objects from which Milo expression are built up are called atoms. 
They are objects without any operands. 

The prompt 
The first atom you encounter in Milo is called a prompt and is displayed as a 
bold-faced question mark. The following line is a prompt. 

? 
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The prompt is used as a place holder to let you know that Milo expects an expres­ 
sion there. For example when the Summation template is chosen from the Tem­ 
plates menu, the following template is inserted: 
? 
}:? 

?=? 

The ~ key cycles the selection range through the prompts in the template so 
they may be filled in at leisure. 

Character atoms 
Typing any alphabet character over a prompt replaces the prompt with that 
character. Upper and lower case characters represent different atoms, and certain 
combinations of the (!e!) and [Shi ft 1 keys produce. Greek character atoms as 
shown in the table below. 

i 
____; 

Greek Name Lower case Upper case Script 

Alpha aŒe!J-ŒJ A [shift 1- Œ) 
Beta ß Œe!J- (ID B [ s hi ft 1 - (ID 
Gamma y Œe!J-@) r (!e!) - [shift 1 -@ 
Delta ô Œe!J-@ i\ (!e!) -[shift 1-@ 
Epsilon E (!e!) - [ shift ] - [) E [ shift 1 - [) 
Zeta ç Œe!J- Œ) Z [ shift 1 - Œ) ·-----i 

~ 
Eta 11 Œe!J- (E) H [ s M ft ) - (E) -

7 
e Œe!J- (ID Theta e Œe!J- [shift ] - (ID i} (!e!) [shift 1 (J ~ 

lota t (!e!) - [ shift 1 - OJ I [ shift 1- OJ ~1 
I 

Kappa l(Œe!J-ŒJ K [ shift ] - Œ) 7 
Lambda ÀŒe!J-[) A Œe!J- [shift]-[) 
Mu µ (!e!) - [ shift ] - ~ M [ shift 1 - ~ 
Nu v (!e!) -[ shift ] - Œ) N [ shift ] - Œ) 

i 

Xi ç Œe!J- Œ) s Œe!J- [ shift l-ŒJ ~ 

Omicron o @) O [ shift ] - @) 
Pi 7t Œe!J- Œ) Il Œe!J- [shift]-@ 7 
Rho p Œe!J- (ID p [ shift ] - Œ) 

52 ~ . . . . . . 
7 
. _J 



, ,I 

'--- Chapter 4 Input Reference 

L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 

Sigma cr @ill - (ID l: @ill - [ shift ] - (ID 
Tau t @ill-(!) T [shift ]-CT) 
Upsilon u @ill - @) Y [sMft ]-@) 
Phi <? @ill - [) <I> @ill- [ shift ] -[) cp@ill( shift ]@) 
Chi x@ill-© X [shift]-(£) 
Psi 'I' @ill - Œ) q, @ill - [ shift ] - Œ) 
Omega ro @ill - ~ n @ill- [shift]-~ 

The Infinity symbol, also an atom, can be invoked by typing@ill- [shift ] - (ID 
or by using the standard macro \inf. The Key Map command in the Edit menu 
provides a list of available atoms from the keyboard. 

Atoms with special meaning in Milo 
The following atoms are evaluated by Milo 
i is the complex number t 
e is evaluated as 2.71826 
1t is evaluated as 3.14159 

The precision of the decimal place is determined by the Option command in the 
Edit menu. (See the chapter on Other Features of Milo). 

Integers 
Keyboard: Keyboard digits 
Menu: None 31 Maximum Integer Length: 2 - 1 

Typing a digit at the? prompt replaces the prompt with that integer. 

Integers are represented as signed 32-bit values and no overflow checking is 
performed during either simplification or typing. This will produce incorrect 
results when dealing with large integers. For example, simplifying 232 in Milo 

.yields O. Typing (ID (ID CT) (ID (ID@)@) Œ) OJ@produces1286608618. Milo 
behaves as expected until you type the final digit, O, which overflows the integer. 
To work happily with numbers greater that 231, use floating point arithmetic, 
described in the following section on strings. 
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Strings 
Keyboard: CJ (single quote) 
Menu: Templates> More> String 
Maximum String Length: 61 characters 

Typing the three atoms "ab e" at the? prompt yields an expression that Milo 
interprets as the product of three character atoms. For a character string to be rep­ 
resented as an atom a single quote is used as a prefix. The insertion point then 
becomes a vertical bar between two double quotes and any typing you do will be 

input iritoa string that can hâve afnio~t 61 characters, Thus,· th~ string "abc" is 
obtainedby typing CJ Œ) (ID© 

t 
'~ 

Strings are distinguished from products of atoms by their character spacing. 
Strings are condensed with hardly any space between characters. Products have at 
least two empty pixels between each character: 

String: abcdef 
Product: abcdef 

The string containing the single letter "A" is different from the character atom 
"A." To illustrate this difference, strings of a single letter are displayed with the 
single quote visible like this: 'A. 

Besides allowing you to create multi-character variables, there are two special uses 
of strings. One is to display floating point numbers and the other is to implement a 
limited macro facility available in the Backslash.ini file on the Milo distribution 
disk. 

Floating point numbers 
Keyboard: O period (see strings) 
Menu:None 
Internal Precision: 18 digits 

Floating point numbers are displayed as strings. Typing a decimal point at the ? 
prompt produces the string "O." followed by an insertion point. Similarly, typing a 
decimal point after an integer converts the integer into a string terminated by a 
decimal point. So to enter the number 1.2, you type (DO œ. 

_J 

_j 
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Scientific Notation 
Keyboard: [ shift ] -[) 
Menu:None 

Typing [shift ] - [) after an integer or a floating point number applies a "times 
ten to the" operator after the number, and leaves the insertion point in the 
exponent. 

So typing OJ [ sh;ft ]-[) produces 1 x 101, where the 1 is an integer. Typing 
OJ O (ID [ shift ]- [) (ID produces 1.2 x 108 where the "1.2" is a string and the 
8 is an integer. 

Standard Macros 
Keyboard: (SJ 
Menu:None 
Maximum Length: 61 characters 

Typing the backslash key, (SJ, which is equivalent to typing CJ (SJ, produces a 
special string beginning with the backslash character. Typing a space after a 
string beginning with a backslash causes Milo to do a table lookup on the entries 
loaded from the file "Backslash.ini'' on startup. Milo will replace the string, if it is 
listed in the Backslash.ini table, with a macro expansion from that table (see Tips 
and Techniques). If the caps lock key was held down when Milo was booted, 
this feature has been disabled. 

For example, typing (SJ Œ) OJ ~ produces the atom 1t after the ~ is typed. 

Polynomials 
Polynomials are constructed from the operations of addition, negation, multipli- 
cation, division and exponentiation. The commands in the simplify menu treat 
the polynomial templates using standard algebra. 

Addition 
Keyboard: G 
Menu:None 

At the prompt, typing Œ) G yields: a+?. After you type the G, Milo expects 
another summand and displays a prompt to ask "plus what?" Plus is an n-ary 
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.operator since there may be an arbitrary number of terms in the sum: 

e 2 -a+-+b-x 
d 

Addition in Milo operates on any selected range. 

I~ 

~ 

Negation and subtraction 
Keyboard: G , @ill - G 
Menu: Templates > Negation 

At the prompt, typing (:) yields:-?. This is unary negation. Typing Œ) (:) at the 
prompt yields a - ?. This looks like a binary subtraction, but is stored internally as 
a+-?. This is important to remember since you can select the-? as single object, 
but you can never select just the+?. 

When the selection is a blackened range, typing (:) is interpreted by Milo as sub­ 
traction. To negate a selected range, type @ill - (:) or select the Negation tem­ 
plate from the Templates menu. Milo has no binary subtraction, only a unary 
negation. This is usually transparent since typing Œ) (:) (ID looks like you would 
expect it to, but internally it is stored as a sum of two objects: the character "a" and 
a unary negation of the character "b." 

Division 
Keyboard: (Z) 
Menu:None 

a 
At the prompt, typing Œ) (Z) yields ? . The division operator operates on any 
selected range. 

- I 

~ 

~ 

~l 
,_J 

Exponentiation 
Keyboard: Ô 
Menu: Templates > Power 

7 
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The exponentiation operator is entered from either the Templates menu or as the 

Ô key from the keyboard. At the ? prompt, typing Œ) Ô yields a ? The expo­ 
nentiation operator operates on any selected range. 

Multiplication 
Keyboard: 0 
Menu:None 

At the prompt, typing Œ) 0 (ID yields "ab." The 0 operator is not necessary, 
however, since multiplication is the assumed operation when typing adjacent 
atoms, so that typing Œ) (ID also yields "ab." 

When the insertion point is a blackened selection range, typing does not replace 
the selection range, it acts on it. So that by typing Œ) (!e) (ID , the "b" does not 
replace the "a," but instead is multiplied by it. To replace an expression requires 
an extra keystroke (delete or backspace) and multiplying two subexpressions 
does not require typing the 0 character. 
For example, typing (:) Œ) 00 Ô Œ) (!e) §) (!e) (!e) G ŒJ 0 (ID (!e) 
(!e) 00 G OJ Œ) produces the following polynomial: 

2 a -2X +-X+12 
b 
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Unary Operators 
Unary operators are those templates which take exactly one subexpression as an 
operand. Atoms have no arguments. Addition and multiplication are n-ary since 
they take 2 or more arguments. Division and exponentiation are binary, while 
negation is unary. Other unary operators are: 

• ✓x the square root operator, 
• n! the factorial operator 
• I x I the absolute value operator 
• (x) the identity operator, 
• <x> the expectation value operator 
• x the overbar operator 
• log x the natural logarithm function 
• sgn x the signum function 
• sin x and all the other trig and inverse and hyperbolic trig functions. 

Negation 16 
Keyboard: ~- G 
Menu: Templates > Negation 
Rewrite Commands: None 
Standard Macro: None 

The Negation operator is entered either from the Templates menu or by typing the 
~ - G key combination. The Negation template operates on a selected expres­ 
sion or an unselected expression that immediately follows the insertion point. 
After inserting the Negation template, Milo leaves the insertion point before the 
expression so typing the backspace key will remove the minus sign. This template 
is different from typing just the minus key, G, which is used for subtraction, a 
short way of typing G G. The Negation template is not used for subtraction. 

Square Root m 
Keyboard: @ill - (ID 
Menu: Templates > Square Root 
Rewrite Commands: Simplify, Number Crunch 
Standard Macro: \sqrt 

The Square Root operator is entered either from the Templates menu or from the 
keyboard with the @ill- (ID key combination. It operates on a selected expres­ 
sion or an unselected expression that immediately follows the insertion point. 

_J 
J 

-! 
_J 

-i 
~i 

_J 

- _J 

-I 

_j 



L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
~ 

L 
L 
L 
L 
L 
L 
L 
~ 

L 
L 
L 
L 
L 
L 

Chapter 4 Input Reference 

After inserting the template, Milo leaves the insertion point before the expression 
so typing the backspace key will remove the radical. When the insertion point 
directly follows an expression, typing @ill - (ID multiplies the previous ex­ 
pression by a new radical and leaves the insertion point inside the radical with 
the selected range over the new prompt. 

Milo treats the Square Root operator as the principal 1/2 power. This may lead to 
incorrect results when simplifying roots. For example 

Jx2 
simplifies to "x" when it should simplify to the absolute value of "x," or " I x I ." 

Factorial RI 
Keyboard: (D 
Menu: Templates> Factorial 
Maximum Size: 12!, or use floating point. 
Rewrite Commands: Evaluate, Number Crunch 
Standard Macro: \fact 

The Factorial operator is entered either from the Templates menu or by typing 
the exclamation mark (D from the keyboard. It operates on a selected expression 
or can be inserted directly at a? prompt. After inserting the Factorial template, 
Milo leaves the insertion point before the expression so typing the backspace key 
will remove the factorial. 

When the insertion point is before an expression, typing (D will create a new 
factorial that is multiplied by the expression that follows it. The selected range is 
always left over the new? prompt. 

The Factorial operator will insert parenthesis around a selected range when 
necessary. 

Milo treats the Factorial operator in the usual way. 0!=1!=12!=23!=6 4!=24 For 5! 
through 12!, the Evaluate command under the Simp menu will expand the facto­ 
rial. 
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Any factorial larger than 12 overflows the 32 bit integers, so the Evaluate com- 
mand will not rewrite them, but the Number Crunch command under the Simp l 
menu will use Sterling's approximation to approximate the factorial as a floating -- ) 
point number. (See the reference chapter on manipulating expressions). 

Absolute Value I? I 
Keyboard: (D 
Menu: Templates> Absolute Value 
Rewrite Commands: Evaluate, Number Crunch 
Standard Macro: \abs 

The Absolute Value operator is entered either from the Templates menu or by 
typing the (D character from the keyboard. It operates on a selected expression, or 
can be inserted directly at a ? prompt. After inserting the absolute value template, 
Milo leaves the insertion point inside the absolute value so typing the backspace 
key will remove the template. When the insertion point is before or after an 
expression, a new absolute value template is inserted and multiplied to any 
adjacent expression. The selected range is left over the new prompt. 

The rewrite commands that recognize this template are Number Crunch and 
Evaluate. Number Crunch takes the absolute value when the argument is a 
number. Evaluate takes the determinate of a matrix when its argument is a 2x2 
matrix. Determinates of 3x3'or larger matrices are not programmed directly into 
Milo's code but may be calculated using Milo's pattern matcher. 

Identity (?) 
Keyboard: (O or [) 
Menu: Templates > Identity 
Rewrite Commands: Evaluate, Number Crunch 
Standard Macro: \id 

The Identity operator is entered either from the Templates menu or by typing the 
(O or [) characters from the keyboard. It operates on a selected expression or 
can be inserted directly at a ? prompt. After inserting the identity template, Milo 
leaves the insertion point inside the parenthesis so typing the backspace key will 
remove the template. When the insertion point is before or after an expression, 
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and a new identity template is inserted it is multiplied to any adjacent expres­ 
sion. The selected range is left over the new prompt. 

The Identity template is used by other templates when necessary. It has no 
mathematical content and is used simply to clarify what may otherwise be an 
ambiguous screen display. 

Overbar I 
Keyboard: None 
Menu: Templates > Overbar 
Rewrite Commands: None 
Standard Macro: \overbar 

The Overbar operator is entered from the Templates menu and has no keystroke 
associated with it by default, though a keyboard equivalent can be assigned to it 
using the Command Key command under the Edit menu (see Tips and Tech­ 
niques). 

The Overbar template is different from the diacritical mark which puts a bar over 
an atom (see Diacritical Markings, this chapter). The diacritical mark is an attrib­ 
ute of an atom, while an Overbar is a template that can be applied to any expres­ 
sion. Standard uses of this symbol include the complex conjugate, logical nega­ 
tion and mean value, depending on the context. There are no built-in rewrite 
rules in Milo that apply to this template. 

Expectation (i) 
Keyboard: None 
Menu: Templates > Expectation 
Rewrite Commands: None 
Standard Macro: \expect 

The Expectation operator is entered from the Templates menu and has no key­ 
stroke associated with it by default though one can be assigned to it using the 
Command Key item under the Edit menu. 

There are no built-in Milo rewrite rules which apply to this template. 
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Trigonometric functions 
Keyboard: None 
Menu: Templates » Trig > sin, cos, sin etc ... 
Rewrite Commands: None 
Standard Macro: None 

A submenu of the Templates menu, the Trig menu contains all the trig, arc-trig, 
hyperbolic trig, and arc-hyperbolic trig functions along with the natural log, 
signum function and sgn, because they are treated by Milo similarly to the trigo­ 
nometric functions. They can be entered through the Trig submenu or by typing 
the characters that make up their names. The natural log operator is called "log" in 
Milo since there is no built-in log base 10. 

After typing (ID (O Milo interprets the expression as a product of two atoms. 

When an Œ) is typed after that, Milo parses the three characters as sin, drawn in 
italics to show that they constitute a single entity. The ? prompt following the trig 

template is left selected. Typing an (ID here will turn sin into sinh and cos into 
cash etc. 

The trigonometric functions are treated in the standard manner. Milo knows that 
log e=l log 1= O; but doesn't know anything about trigonometry. Under the Tfm 
menu, the Trig-> Base Trig will write tan, ese, sec, cot in terms of sin and cos. 
The Trig-> Exponential command will rewrite trig expressions in terms of sums of 
exponentials. Other trigonometric identities are available as rules in the Tables of 
Formulas folder on the Milo distribution disk that may be applied using the 
pattern matcher. 

N-ary Operators 

Substitution il?=? 
Keyboard: @!]- (SJ 
Menu: Templates > Substitution 
Rewrite Commands: Evaluate, Eval Substitutions 
Standard Macro: None 

When an expression is selected or the insertion point directly follows an unse­ 
lected expression, the Substitution template can be applied to that expression 
using @ill- (SJ. If the insertion point is directly before an expression and the 
substitution template is inserted, Milo will put that expression in the substitution 

field. 
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The Evaluate and Eval Substitutions commands in the Simp menu treat the 
Substitution operator as follows: In alb= e , all occurrences of "b" in "a" are 
lexically replaced by "c." 

? 

Eval Between il;=? 
Keyboard: None 
Menu:None 
Rewrite Commands: Evaluate 
Standard Macro: \between 

The Eval Between template is set to perform two substitutions on an expression 
and the Evaluate command in the Simp menu subtracts the second result from 
the first. 

The Evaluate command treats the between operator as follows: 

end 
xlexpr = begin +-xlexpr = end-xlexpr = begin 

? 

~i 
Summation ? =? 
Keyboard: @E!] - [-s-hi-ft-]- (ID 
Menu: Templates > Summation 
Rewrite Commands: Evaluate, Eval Sums or Products 
Standard Macro: \sum 

The Summation template can be inserted through the Templates menu or by 
using the @E!]- [shift ] - (ID keyboard combination. 

The simplify commands Evaluate and Evaluate Sums or Products treat the sum­ 
mation operator as follows. In the expression 

d 

~a 
b=c 

all occurrences of "b" in "a" are lexically replaced by "c"and the new expression 
is added to the existing one. Then "c" is incremented and the process is repeated. 
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Holding down the [Shi ft ] key while selecting the Eval Sums or Products com­ 
mand will expand the sum or product provided both the limits are integers and 
their difference is less than 101. 

? 

TT? 
Product ?=? 
Keyboard: @ill - [ shift ] - Œ) 
Menu: Templates > Product 
Rewrite Commands: Evaluate, Eval Sums or Products 
Standard Macro: \prod 

The simplify commands Evaluate and Evaluate Sums or Products treat the 
Product operator as follows. In the expression below all occurrences of "b" in a are 
lexically replaced by "c" and the new expression is multiplied to the existing one. 
Then c is incremented and the process is repeated. 

d 

TTa 
b=c 

Holding down the [Shi ft ] key while selecting Eval Sums will completely expand 
the product provided that the limits of the product are both integers and their dif­ 
ference is less than 101. 

limi 
Limit ? ... ? 
Keyboard: None 
Menu:None 
Rewrite Commands: None 
Standard Macro: \lim 

The Limit operator is purely syntactic, no rewrite commands currently attach any 
meaning to it. 

Log Base b / og ?i 
Keyboard: None · 
Menu:None 
Rewrite Commands: Evaluate 
Standard Macro: \logb 

The Evaluate command I og X rewrites as follows: 
b 
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log x 
I og bx +- / o g b 

The Number Crunch command in the Simp menu evaluates the Log Base b 
template numerically if its arguments are numbers. 

Vectors, matrices, super/subscripts 

Div (Divergence) V•i 
Keyboard: @ill - [ shift ·] - Œ) @ill- GJ 
Menu: Templates > More > Div 
Rewrite Commands: None 
Standard Macro: \div 

Grad (Gradient) V i 
Keyboard: @ill - [ shift ] - Œ) 
Menu: Templates > More > Grad 
Rewrite Commands: None 
Standard Macro: \grad 

Curl Vxi 
Keyboard: @ill - [ shift ]- Œ) @ill - [ shift ] - Œ) 
Menu: Templates > More > Curl 
Rewrite Commands: None 
Standard Macro: \curl 

Laplacian V2i 
Keyboard: None 
Menu: Templates > More > Laplacian 
Rewrite Commands: None 
Standard Macro: \lap 

The Div, Grad, Curl, and Laplacian operators are the standard vector calculus 
derivatives. The Rectangular, Cylindrical, and Spherical commands listed in the 
Tfm menu, expand Div, Grad, and Curl in each coordinate system. Div and Curl 
will expand only when their argument is a three-element row or column matrix. 
The Laplacian template has no built-in meaning to any of Milo's rewrite com­ 
mands. 

Vf 
~ 

V•E 
~ 

VxB v2<1> 
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Dot product i• ? 
Keyboard: @ill - GJ 
Menu: Templates > More > Dot 
Rewrite Commands: Matrix Algebra 
Standard Macro: \dot 

See Cross product below. 

Cross product ix ? 
Keyboard: @ill- [ s M ft ] - Œ) 
Menu: Templates > More > Cross 
Rewrite Commands: Matrix Algebra 
Standard Macro: \cross 

The Dot and Cross operators are the standard vector products. The Matrix Algebra 
command under in the Tfm menu evaluates the Dot or Cross product when both 
of its operands are three-element row or column matrices. No other items affect 
them. 
~ ...JI,, 

A•B 
~ ...JI,, 

vxB 

Matrix i 
Keyboard: @ill - ~ 
Menu: Templates > More > Matrix 
Rewrite Commands: Matrix Algebra 
Standard Macro: \matrix 

Applying the Matrix template creates a lxl matrix. Typing (return] in a matrix 
creates a new row. Typing Q in a matrix moves to or creates a new column. 

The Matrix Algebra command in the Tfm menu will multiply or add matrices of 
the appropriate rank and multiply terms into a matrix. 

--- 
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Upper Index ?i 
Keyboard: ~ - (ID 
Menu: Templates > More > Upper Index 
Rewrite Commands: None 
Standard Macro: None 

? Lower Index · 6 
Keyboard: ~ - [) 
Rewrite Commands: None 
Standard Macro: None 

Menu: Templates > More > Lower Index 

The Upper and Lower Index templates, when applied to expressions which do 
not already have indices, will add an upper or a lower index to the expression. 
The Upper Index template is different from an exponent, though it may look the 
same. The index templates are n-ary operators that themselves can take on an ar­ 
bitrarily number of upper and lower indices. 

If the insertion point is after an index, typing Q will add another index. If the 
insertion point is after an index and either command is invoked it will add an 
index to the index. If the insertion point is after an upper index and you want to 
add a lower index to the whole index expression then select the expression and 
type ~ - [) to add a lower index. This allows for fast typing of complicated 
expressions. 

For example, typing the following five sequences of keystrokes 

1) @!)-[shift ]-(ID~ -(B)@D-Œ) Q@D- (ID 
2) Œ) ~ - (ID Q) 
3) (shift)-@~-[) Œ) ~ -[) (D 
4) [shift ) - @ ~ - (ID @ill -Œ) Q@ill - (ID ~ ~ ~ -[) @ill -(ID 
5) @ill- [shift ) - (ID ~ - (ID @ill- Œ) ~ - (ID CJ (!) ~ ~ Q 
@ill- (ID~ -(ID CJ G 

produces the following results: 

n ¡-Oß 2) xi 3) Nx i 4) ~ß s) f"l + ß" 
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Calculus Templates 
Milo has templates for four kinds of derivatives, three kinds of differentials and 
two kinds of differential operators. 

Everything but the four derivative templates is used for notation purposes only. 
None of the other derivative templates can be evaluated in Milo unless you create 
a specific rule to do so with the pattern matcher. 

d? 
Total derivative di 
Keyboard: ~- [ shift ] - (I) 
Menu: Templates > Cale > Total Derivative 
Rewrite Commands: Eval Derivative, Evaluate 
Standard Macro: \der 

The Total Derivative template is a binary operator. While both of its operands can 
be arbitrary expressions, it is customary for the variable of differentiation to be an 
atom. 

The Eval Derivative command under the Simp menu evaluates both total and 
partial derivatives. In the Total Derivative template, all atoms are treated as if they 
are dependent on the variable of differentiation. The Evaluate command in the 
Simp menu will evaluate only one derivative while applying the chain rule. The 
Move Right and Move Left commands recognize derivatives to the extent that a 
term can be dragged out of a derivative only if it does not depend on the variable 
of differentiation. 

a? 
Partial der-ivative ai 
Keyboard:~ - (I) 
Menu: Templates > Cale > Partial Derivative 
Rewrite Commands: Eval Derivative, Evaluate 
Standard Macro: \derp 

The Partial Derivative template in the Cale submenu of the Templates menu is a 
binary operator. While both operands can be arbitrary expressions, it is customary 
for the variable of differentiation to be an atom. 

The Eval Derivative command under the Simp menu evaluates both total and 
partial derivatives. In a partial derivative template, all the atoms other than the 
variable of differentiation are treated as constants. The Evaluate command in the 
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Chapter 4 Input Reference 

Simp menu will evaluate one level of a derivative without applying the chain 
rule. Click algebra recognizes derivatives in that you can drag a term out of a de­ 
rivative only if it doesn't depend on the variable of differentiation. 

d1i 
Nth Total Derivative d? 
Keyboard: None 
Menu: Templates > Cale > Nth Total Derivative 
Rewrite Commands: Evaluate 
Standard Macro: \nth 

The Nth Total Derivative operator is inserted from the Cale submenu of the 
Templates menu. The Evaluate command in the Simp menu expands the Nth 
Total Derivative operator, provided that "N" is an integer between O and 20. If 
"N" is not an integer, the Evaluate command will leave the expression un­ 
touched. 

d2u d du 
For example, - is expanded to -- by the Evaluate command because 

dx dxdx 
"N" is an integer between O and 20 but 
dnu 
- is not affected by the same command. 
dx a?i 
Nth Partial Derivative a? 
Keyboard: None 
Menu: Templates > Cale > Nth Partial Derivative 
Rewrite Commands: Evaluate 
Standard Macro: \nthp 

The Nth Partial Derivative operator is inserted using the Cale submenu of the 
Templates menu. The Evaluate command will expand the Nth Partial Derivative 
operator provided that "N" is an integer between O and 20. If "N" is not an 
integer, the Evaluate command will leave the expression untouched. The Evalu­ 
ate command will expand both Nth Partial and Nth Total derivatives if the "N" 
is an integer. 
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a2u a au 
So - is expanded to --a- by the Evaluate command because "N" is an ax ax X 
integer between O and 20 but 

étu is not affected by the Eval Derivative command. 
ax 

? 

J id? 
Definite Integral ? 
Keyboard: ~- [ shift ] - (D 
Menu: Templates > Cale > Definite Integral 
Rewrite Commands: Eval Integrals 
Standard Macro: \defint 

The Definite Integral operator is inserted using either the Cale submenu of the 
Templates menu or the~ - [shift ] - (D key combination. The standard macro 
\defint can be used to insert the template. 

The Eval Integrals command evaluates this template by rewriting it as an indefi­ 
nite integral evaluated between its limits. 

Indefinite Integral Jld? 
Keyboard: @I)- (D 
Menu: Templates> Cale> Indefinite Integral 
Rewrite Comm.ands: Eval Integrals 
Standard Macro: \int 

The Indefinite Integral operator is inserted using either the Cale submenu of the 
Templates menu or using the @I) - (D key combination. The standard macro 
\int can be used to insert the template as well. 

The Eval Integrals command in the Simp menu evaluates polynomial indefinite 
integrals. Other indefinite integrals must be evaluated using Milo's pattern 
matcher. 
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Ji 
Path integral ? 
Keyboard: None 
Menu: Templates > Cale > Path Integral 
Rewrite Commands: Eval Integrals 
Standard Macro: \path 

The Path Integral operator is inserted using either the Cale submenu of the Tem­ 
plates menu or the standard macro \path. 

Loop integral ~id? 
Keyboard: None 
Menu: Templates> Cale> Loop Integral 
Rewrite Commands: Eval Integrals 
Standard Macro: \loop 

The Loop Integral operator is inserted using either the Cale submenu of the 
Templates menu or the standard macro \loop. 

Comma ,; 
Keyboard: None 
Menu: Templates > Cale > Comma 
Rewrite Commands: None 
Standard Macro: \comma 

The Comma is inserted using the Cale submenu of the Templates menu. It has no 
built-in meaning and is not evaluated by Milo. It is purely a syntactic unary 
operator. 

Covariant Derivative ;i 
Keyboard: None 
Menu: Templates > Cale > Covariant Derivative 
Rewrite Commands: None 
Standard Macro: \; 

The Covariant Derivative template is inserted using the Cale submenu of the 
Templates menu. It has no built-in meaning and is not evaluated by Milo. It is 
purely a syntactic unary operator. 
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d 
Differential Operator d~ 
Keyboard: None 
Menu: Templates> Cale> Differential Operator 
Rewrite Commands: None 
Standard Macro: \ totalop 

The Differential template looks the same on the screen as a product. To tell them 
apart, try to select the II d" with the mouse. If the II d" is selectable by itself, it is an 
atom and part of a product. If the 11d" is not selectable by itself, it is part of the dif­ 
ferential operator. 

a 
Partial Operator ai 
Keyboard: None 
Menu: Templates > Calc> Partial Operator 
Rewrite Commands: None 
Standard Macro: \partialop 

_ _J 

Differential d~ 
Keyboard: None 
Menu: Templates> Cale> Differential 
Rewrite Commands: None 
Standard Macro: \d 

Variation 6~ 
Keyboard: None 
Menu: Templates> Cale> Variation 
Rewrite Commands: None 
Standard Macro: \ var 

Delta Lii 
Keyboard: None 
Menu: Templates > Cale > Delta 
Rewrite Commands: None 
Standard Macro: \delta, \Delta 
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Chapter 4 Input Reference 

Bra (il 
Keyboard: None 
Menu: Templates > Cale > Bra 
Rewrite Commands: None 
Standard Macro: \ bra 

Ket li) 
Keyboard: None 
Menu: Templates > Cale > Ket 
Rewrite Commands: None 
Standard Macro: \ket 

Bracket (i I ? ) 
Keyboard: None 
Menu: Templates > Cale > Bracket 
Rewrite Commands: None 
Standard Macro: \bracket 

All of the above seven operators have no meaning anywhere else in Milo and are 
included only for purposes of display. 

Diacritical Marks 
Atoms can have diacritical marks associated with them. The diacritical marks 
that Milo provides include primes, dots, tildes, bars and vector symbols. The 
Simplify command may not recognize some diacritical marks. For example a + a 
incorrectly simplifies to 2a. 

~ 
Vector a 
Keyboard: @ED- Œ) 
Menu: Diac > Vector 
Rewrite Commands: None 
Standard Macro: None 

Typing @ED - Œ) on a selection will put vector symbols over all the atoms in 
the selection, and remove any vector symbols already there. An atom can have 
either a tilde, a bar, or a vector symbol over it, but cannot have any combination 
of them at the same time. 
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Bar a 
Keyboard: Q 
Menu: Diac > Bar 
Rewrite Commands: None 
Standard Macro: None 

Typing underscore Q after an atom puts a bar over it. Typing Q again removes 
the bar. An atom can have either a tilde, a bar, or a vector symbol over it, but 

cannot have any combination of them. 

Hat â 
Keyboard: ~- (ID 
Menu: Diac > Hat 
Rewrite Commands: None 
Standard Macro: None 

Typing ~ - (ID after an atom puts a hat over it. Typing ~ - (ID again 
removes the hat. An atom can have either a tilde, a bar, or a hat symbol over it, but 

cannot have any combination of them. 

Dot a 
Keyboard: O 
Menu: Diac > Dot 
Rewrite Commands: None 
Standard Macro: None 

Typing a period O after an atom puts a dot on top of it. Typing the O key again 
makes it a double dot, then a triple dot, and then removes the dots. 

Prime a• 
Keyboard: Œ) (backquote) 
Menu: Diac > Prime 
Rewrite Commands: None 
Standard Macro: None 

Typing the backquote key Œ) after an atom puts a prime after it. Typing the Œ) 
key twice makes it a double prime, and typing three times makes it a triple prime. 
The fourth consecutive backquote typed will remove all the prime markings from 

the atom. 
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Tilde 'a 
Keyboard: Ô 
Menu: Diac > Tilde 
Rewrite Commands: None 
Standard Macro: None 

Typing a tilde Ô after an atom puts a tilde over it. Typing Ô again removes it. 
An atom can have either a tilde, a bar, or a vector symbol over it, but cannot have 
any combination of the three. 

Sub Tilde -ª 
Keyboard: @ill - [ s M ft ] - CJ 
Menu: Diac > Sub Tilde 
Rewrite Commands: Simplify, Multiply Out 
Standard Macro: None 

Typing @ill - [shift ] - CJ after an atom puts a tilde under that atom. Typing 
@ill- [shift ] - CJ again removes the subtilde. An atom can have a tilde or a 
bar beneath it, but not both. 

Sub Box ? 
Keyboard: @ill - [ Shi ft ]- G 
Menu: Diac > Sub Box 
Rewrite Commands: Simplify, Multiply Out 
Standard Macro: None 

Typing@ill - [shift ] - G after an atom puts a bar under it. Typing 
@ill- [ shift ]- G again removes the bar. An atom can have a tilde or a bar 
beneath it, but not both at the same time. 

Dummy a 
Keyboard: ~ - @ill - @ 
Menu: Diac > Dummy 
Rewrite Commands: None 
Standard Macro: None 
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The Dummy template is used to designate wildcard variables in user-defined 
rewrite rules. Dummy variables are shown in bold face and will take on the value 
of any expression when using the Apply Rule command in the Rules menu. To 
create a dummy variable, use the~-~ -@ key sequence or the Dummy 
command in the Diac menu on a selected atom or with the insertion point directly 

after the atom. 

Other Input Commands 

Assignment ~ +-? 
Keyboard: (D 
Menu: Templates > More > Assignment 
Rewrite Commands: Apply Rule 
Standard Macro: None 

The assignment operator is read "gets." The Pattern Matcher replaces all occur­ 
rences of the left side of the assignment operator with the right side. For example 
in the assignment a+- b, all occurrences of "a" will be replaced with "b" by the 
Apply Rule command. The pattern matcher treats this the same as a = b, in fact the 
equals operator can be used interchangeably with the assignment operator in this 
context. 

Next expression ? i 
Keyboard: GJ 
Menu: Templates> More> Next Expression 
Rewrite Commands: None 
Standard Macro: None 

The Next Expression operator is an n-ary operator used to build more than one 
expression on one line. 
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Choice Function œ) 
Keyboard: None 
Menu: Templates > More > Choice Function 
Rewrite Commands: Evaluate 
Standard Macro: \choice 

~ 
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Chapter 4 Input Reference 

The Choice operator is the standard combinatorics choice function. The Evaluate 
command under Simp menu evaluates the choice function in the following way: 

(n) ni 
m = m!(n-m)! 

Commutator [i, ?] 
Keyboard: None 
Menu: Templates > More > Commutator 
Rewrite Commands: None 
Standard Macro: \comm 

The Commutator template is a binary operator with no built-in meaning any­ 
where else in Milo. 

Anticommutator {i, ? } 
Keyboard: None 
Menu: Templates > More > Anticommutator 
Rewrite Commands: None 
Standard Macro: \acomm 

The Anticommutator is a binary operator with no built-in meaning anywhere 
else in Milo. 

Function i(?) 
Keyboard: @e!J-(ID 
Menu: Templates > More > Function 
Rewrite Commands: None 
Standard Macro: None 

The Function operator describes a functional dependence in Milo and has no 
built-in meaning anywhere else in the program. Typing Q after the parameter 
will add new parameters. 
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Dagger i+ 
Keyboard:@D-[sMft ]-CT) 
Menu: Templates> More> Dagger 
Rewrite Commands:None 
Standard Macro: None 

The dagger operator is purely syntactic unary operator with no built-in meaning 
anywhere else in Milo. 
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Chapter 5 Rewriting Expressions 
What this chapter contains 
All the simplify commands contained in the 
• Simpmenu 
• Tfmmenu 

This chapter describes in detail every Milo command relating to the 
manipulation of expressions. Each entry in the chapter describes a Milo 
command and information about how to use that command. 

Most of the items in the Simp menu simplify an expression by making it smaller 
and more elegant. Most of the items under the Tfm menu transform an expres­ 
sion expanding it into a larger, more explicit form. The Rules menu, discussed in 
the following chapter is used to define custom rewrite rules. 

Milo's ability to graph expressions is not discussed in this chapter, but reserved 
for the chapter entitled Graphing Expressions. 

The format of this chapter 
Each rewrite command in this chapter is listed as it appears in Milo's menus. 
Relevant information such as keyboard equivalents and modifier keys that alter 
the function of the command are listed directly below the command name. The 
location of the command in the menus is shown using the greater-than symbol > 
to denote submenus and finally to point to the command name. This is followed 
by a complete description of the command. 

Manipulating Expressions in Milo 
To manipulate an expression in Milo, first select it and then choose a com- 

w 
mand from the menus. In some cases a rewrite command operates on a range 
larger than the selected expression, but in all cases the commands affectonly 
expressions on the current line. 

Complicated expressions can be quickly massaged by hand using correctness­ 
preserving transformations. These are commands that transform an expression 
into an equivalent form. The most useful correctness-preserving transformations 
in Milo are the move-right and move-left commands (See the Tips and Tech­ 
niques chapter). These commands allow algebraic transformations to be done in 
a WYSIWYG fashion, by moving terms around in an equation with the mouse. 
Milo applies the appropriate rules to maintain the correctness of the expression. 
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The Simp Menu 

Simplify 
Keyboard: ~- Œ) 
Menu: Simp > Simplify 
Modifier Keys: @ill [-s-M-ft-] 

') 
-- J 

_ __i 

The Simplify command listed in the Simp menu performs algebraic simplification. 
It lies at the heart of Milo's power. The Simplify command will perform the 
following tasks: 

• 32-bit integer arithmetic 
• Group terms in a product 
• Group terms in a sum 
• Cancel common terms in the numerator and denominator of a fraction 
• Recognize the iota ( @ill-[ s M ft ] - (O ) as the complex number i. 

In all of the following examples, selecting the left hand side of an equality and 
choosing the Simplify command from the Simp menu will produce the right hand 
side of the equality. 

Integer Arithmatic 

Ox=O 

a+a=2a 

1+1=2 31=6 41=24 log e=l log 1=0 

Grouping Terms 

(3a + 1) + {b2-a +2) = b2 +2a + 3 ex eY =ex +y 

Canceling in a fraction using the Simplify command 

-I 
__ J 

-· ·1 
-- _/ 

) 

_j 

.! 
- _ _) 

xª -b+a -=X 
Xb 

2a4b3 abc ab ' ------ 
4a3bac2 2c -ì 
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Interpreting the complex i 

H=1 t2=-1 23 --i t - J-ab=tJaJb 

The @D- Simplify command x ax 
The Simplify command automatically rewrites ab as b. In some situations this 
is undesirable. The distributive rule is not applied to an expression if the @D 
key is held down when choosing the Simplify command. 

In the following example, @!J - Simplify will not rewrite the expression while 
Simplify will combine the fractions: 

@!)- Simplify: 

Simplify: 

a+l e a+l e --=-- 
b d+l b d+l 

a+l e c{a+l) 
bd+ i= b (d + o 

In this line Simplify will not group terms as is shown, but @!) - Simplify will: 

Option-Simplify: 1 met er + 3 met er =4 met er 
sec sec sec 

Simplify: 1 meter +3 meter 
sec sec 

meter 3meter --+--- 
sec sec 

The [ sMft ]- Simplify 
With the [ s M ft ] key held down, Simplify first extends the selection to be the 
whole line, then performs a standard simplify operation. 
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Limitations of the Simplify command 
All integer arithmetic is done in 32-bits with the Simplify command. No overflow 
checking is performed so errors do occur with large integers as shown below. 
Watch carefully for this and use floating point numbers if you suspect a potential 
overflow. 

MM MM =-1221111740 31 2 = --2147483648 232=0 

Milo's simplifier also makes errors simplifying J X 2 . Milo simplifies this to "x" 
when the result should be I)( I . 

The simplifier also makes errors when it sees "0/x," replacing it with zero for all 
"x," so 0/0 gets replaced by O. Again, you need to watch for these restrictions. 

Multiply Out 
Keyboard: (jj) - (ytJ 
Menu: Simp > Multiply Out 
Modifier Keys: @!) 

The Multiply Out command in the Simp menu does everything that the Simplify 
command does, but also distributes multiplication over addition. This command 
goes through the entire selected range and wherever a sum is a term of a product, 
it multiplies out the product. For example: 

(a+b) (a-b) =a2-b2 

~2+x+1) (x-1) =x3-1 

If a sum is raised to a positive integer power less than 20, the Multiply Out com­ 
mand will multiply out that power. That is, (a+b)2 becomes a2+2ab+b2• Applying 
the Multiply Out command to 

(a-b)4 =a4-4ba3 +6a2b2-4ab3 +b4 

we get this: 

{a+ 1) 10 =a 10 + roa" +45a8 + 120a 7 + 21oa6 + 252a5 +210a4 + 120a3 +45 a2 + 10a + 1 

ì __ ) 
------¡ 
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@ill- Multiply Out 
If the @ill key is pressed when choosing the Multiply Out command, Milo will 
not pass through the the entire selected range, but will stop multiplying out 
terms after applying its rewrite rules once. 

To illustrate this, take the expression a(b+c(d+e)). Multiply Out rewrites this as 
ab+acd+ace, while@ill- Multiply Out rewrites it as ab+ac(d+e). 

Add Fractions 
Keyboard: ~- @ 
Menu: Simp > Add Fractions 
Modifier Keys: None 

The Add Fractions command in the Simp menu does everything that the Sim­ 
plify command does, but also adds fractions by putting them over a common 
denominator. For example 

a e ad+bc -+- -- b d becomes bd 

The Simplify command will not group terms of a fraction. The Add Fractions 
command must be used explicitly to do this: 

Simplify: 
e e e e -+-=-+- 
2 3 2 3 

Add Fractions: 
e e 5c -+-=- 
2 3 6 
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Add Fractions will put only the first two terms of a sum over a common denomi­ 
nator. It must be used repeatedly to simplify complicated fractions: 

1 1 1 y + X 1 y + X 1 Z (y + x) + X y 
-+-+-=--+- --+-=--------- 
X y z xy z xy z xyz 

1 1 b-a ---=- ª b ab 

a e ad+bc 
-+-=--- 
b d bd 

b ac+b 
a+-=-- 

c e 

Order Sum 
Keyboard: [@- @ill -( s M ft ] - (ID 
Menu: Simp > Order Sum 
Modifier Keys: [ s M ft ] 

[ sMft ]- Order Sum 
Holding down the [-~-h-; f-t-] key when choosing the Order Sum command will 

order the polynomial in increasing powers of the selected variable: 

xs x4 x3 x2 (x2 x3 x4 xs~ 
-+-+-+-+X+l=l+X+ -+-+-+- 
5! 24 6 2 2 6 24 5! 

The Order Sum command orders polynomials in decreasing powers of a variable. 
To use it select the variable with respect to which you want the polynomial 
ordered, then issue the Order Sum command. Milo will look for the first sum 
above the variable and order that sum in decreasing powers of the selected 
variable. In the following example, selecting the variable "x" in the expression on 
the left of the equal sign and choosing the Order Sum command will produce the 
expression on the right: ,_ - 1 

x2 x3 x4 xs xs x4 x3 x2 
-+-+-+1+-+X=-+-+-+-+X+l 
2 6 24 5! 5! 24 6 2 

, __ j 



~ 

e 
L 
L 
L 
LI 

e 
~ 

L 
L-1 

e 
~ 

l..' 
e 
L 
e 
L 
e 
L 
L 
L 
L 
L 
e 
L' 
C' 

Chapter 5 Rewriting Expressions 

Number Crunch 
Keyboard: ~- Œ) 
Menu: Simp > Number Crunch 
Modifier Keys: None 

The Number Crunch command first changes all integers to floating point num­ 
bers in an expression and then numerically evaluates the expression. All argu­ 
ments to the Number Crunch command must be able to be converted into 
floating point numbers. In the following examples, the left side of the equal sign 
is number crunched to produce the right side. 

1 = 1. tan0=O. . 1t 1 Sin-= . 
2 

Number Crunch replaces "re" and "e" with floating point numbers unless the "e" 
is the base of an exponent, or part of a string. 

1t=3.14159 8=2.71828 e3 = 20 .0855 

Floating point calculation is not exact. Sin re should number crunch to exactly O: 

sin 1t=4.33681 x10-19 

Number Crunch crunches big ugly expressions in one step: 

1 1.5 
---+3.---2 

sin 1.5cos 1.5 1.5 +192.25tan 1.5=1240.17 

J1.52+1 

Number Crunch will display the error message NaN, meaning "not a number" 
for illegal operations, and INF, for infinity, when the program overflows. 

NaN 
INF 

1 1 ---= - NaN o o 

Nota Number 
Infinity 

1 
0-= NaN o 

Illegal operation performed 
Overflow detected 

~=NaN 
o 

!=INF 
o 
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Move Right 
Keyboard: @!J - O 
Menu: Simp > Move Right 
Modifier Keys: [ s M ft ] 

Move Left 
Keyboard: @!J - Q 
Menu: Simp > Move Left 
Modifier Keys: [ SM ft ] 

These commands as their names suggest are used to move terms of an expressions 
right or left. The intent is to bring algebraic simplification to an intuitive level. 

The Move Left and Right, listed in the Simp menu, are catch-all commands. They 
will apply different rules depending on the context. If the selection is a term in the 
middle of a product, these commands will commute that term with one of its 
adjacent terms. 

Whatever the context, Milo will try to apply a correctness-preserving algebraic 
rule to move the selection in the desired direction. If correctness cannot be pre­ 
served, Milo will not move the term. 

The Move Right and Move Left commands can be executed from the Simp menu, 
their command-keys, or holding down the ~ key and clicking to the right or left 
of an expression. 

Command-clicking (holding the ~ key down while clicking the mouse) to the 
right or left of a selected range is exactly the same as selecting the Move Right or 
Move Left menu item. Command-clicking above or below an expression works 
in the same way to move expressions from the numerator to the denominator of 
a fraction or vice-versa, while preserving the correctness of the expression. 

[ sMft ]- Move Right 
[ sh;ft ]- Move Left 
With the [ SM ft ] key held down, the Move Right and Move Left commands will 
attempt to move a term all the way to the right or left side of an expression. 
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Chapter 5 Rewriting Expressions 

@ill- Move Right 
@ill- Move Left 
With the @ill key held down, the Move Right and Move Left commands will 
attempt to distribute a selected range into the adjacent term. 

Examples 
In the following examples, selecting the bold faced "x" and choosing Move Left 
(either with the mouse, from the menu, or from the keyboard as ~-GJ, or by 
command-clicking to the left of the selection range) will produce the expression 
on the right. In most cases either Move Right, or@ill - Move Right will do the 
inverse operation to get back to the original expression. 

abx cd ➔ ax bed a=x +b ➔ a-x =b 

a=x b ➔ 1 x a+x b ➔ X (a+b) a-=b 
X 

Jxa ➔ Ja.Jx (xab) ➔ X (ab) 

(x b)n ➔ xnbn xn ➔ X xn-1 

xa a a ➔ 1 a - ➔ X- - -- 
b b xb xb 
a ➔ a 
a°?'ªb x-ab at 
Jx abdv ➔ X Jabdv 

The following equation may be solved for "x" by moving the "by" term across 
the equal sign, then moving the coefficient "a" across the equal sign: 

ax+by=c ax=-by+c xa=-by+c x=!.(-by+c) 
a 
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Factor 
Keyboard: (jj) - [1 
Menu: Simp > Factor 
Modifier Keys: @ill [-s-h;-ft-] 

The Factor command in the Simp menu factors a term out of a product. The Factor 
command does not do polynomial factorization. If you want to do polynomial 

· factorization, you must first guess what one of the factors might be and then use 
the Long Division command to test it. To use the Factor command, selectthe 
desired term and execute the command. The factoring process is equivalent to 
repeatedly moving the term left. For example, factoring one of the "a's" out of 
ab+ca+d yields a(b+c+d/ a). 

ax +bx X {a+b) 

a2 +a+ 1 aa1+a+l a(a+ 1 +l) 
@ill- Factor 
With the @ill key down, Factor will only factor the selected term out of terms 
which contain it. This is useful for grouping terms. For example, with an "a" 
selected in the expression ab+ca+d, the @ill - Factor command produces 
d+(b+c)a. 

The following example was generated by first selecting the "x2" term and doing 
an@ill- Factor, then selecting an "x" and doing another @ill- Factor. 

ax2+bx+c+dx2+ex+d (bx +e +ex +d) + (a +d) x2 

c+d+x{b+e) +x2{a+d) 
The following was done by selecting the i and doing @ill- Factor. 

-, 

__) 

,-: 
_ _) 

a+bt+c+dt {a+c) +(b+d)1 
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Chapter 5 Rewriting Expressions 

Solve For 
Keyboard: ~- ŒJ 
Menu: Simp > Solve For 
Modifier Keys: None 

The Solve For command in the Simp menu isolates an expression on one side of 
the equal sign. This is accomplished by applying the inverse operations of every 
term on the same side to both sides of the equality. For example, to solve for "x" 
in ax+by=e, select the "x" and choose Solve For. 

Note that in the expression x2+2x+1=0, selecting an "x" and choosing Solve For 
does not combine the two "x' s" in the line, so it has merely isolated the term. 

The following examples were generated by selecting the "x" in the expression on 
the left and choosing Solve For. 

ax+by=c ➔
Ef+x+l=O ➔
x2+x+l=O ➔
y =log x ➔
Jy=x ➔

Rsin 2x+by+cJz=O ➔

Distribute 
Keyboard: ~ - Q) 
Menu: Simp > Distribute 
Modifier Keys: None 

x=c-by 
a 

X= J-+;j-1 

X=-X2-1 

eY =X 

y=x2 

x =asín J-by-c Jz 
JR 

The Distribute command, listed in the Simp menu, is a catch-all command that 
does different things depending on the context. The following lists the situations 
where the Distribute command is most useful. 
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• Distributing division over addition 
• Dealing with radicals and powers 
• Distributing multiplication over addition 

One of the more common uses of this command is to distribute division over 
addition. 

a+b ab 
After selecting the expression -

2
- the Distribute command produces 2 + 2 . 

In this case, the Add Fractions command in the Simp menu performs the transfor­ 
mation in the opposite direction. 

The Distribute command can be useful when dealing with radicals and powers. 

bJa distributes to Jb2a, ba2 distributesto{Jba)
2
. The Distribute_ 

command does the same things in a fraction as it does in a product, i.e. Ja 
- ( ~2 b a a2 a 

becomes J b2 and b becomes J b . 

In the above cases, the Simplify command will perform the inverse transformation 
of the Distribute command. 

The Distribute command also will distribute multiplication over addition. Select­ 
ing the expression a(b+c) and executing the Distribute command produces 
ab+ac. 

In general, if the selection range is a product then the Distribute command does 
the same things as ~- Move Right or ~ - Move Left. 

'~ 

:~ 

__ __) 

a+b 
2 ➔

➔

Ja 
b ➔

a b 
aJb -+- 

2 2 

(aJ~2 a2b2 

J:2 Ja 
Jb 

➔ Ja2b 

a2b ➔ (ab)
2 

_J 

➔ J~ 
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ab 

b ➔ (b~1r 
a+b+c ➔ -(-a-b-c) 

a(b+c) 

-a-b-c 

➔ ab+ac 

➔ -(a+b+c) 

b 
¿U+V+W 

n=a 
➔

b b 
¿U+ ¿V+ 

b 
¿W 

n=a n=a n=a 

Distribute Over Equality 
Keyboard: (jj)- G 
Menu: Simp > Distribute Over Equality 
Modifier Keys: None 

The Distribute Over Equality command, located in the Simp menu, is used to 
perform the same operation to both sides of an equal sign. 

In the following examples, selecting the expression on the left and choosing the 
Distribute Over Equality command will produce the expression on the right. 

(a=b) + 1 

(a=b)2 
➔

➔

a+l=b+l 

a2=b2 

J(a=b) 

-(a=b) 

➔ Ja=Jb 

➔ -a=-b 

J (x2-a=b) +a ➔ J (x2-a) +a= Jb +a which simplifies to x = Jb+a 
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Evaluate 
Keyboard: (jj) - [) 
Menu: Simp > Evaluate 
Modifier Keys: None 

The Evaluate command is a catch-all command that does many unrelated things 
depending on the selected range. 

Evaluating a Derivative 
The Evaluate command will evaluate the top level of a total or partial derivative. 
(This is the same as the @ill-Eval Derivative command) 

d t2 -e 
dt 

t2 d 2 
e dt l 

Evaluating a Nth derivative 
If a derivative is raised to a positive integer less than 20, the Evaluate command 
will rewrite a derivative as n first derivatives. 

ª4 atf (t ) a a a a 
at at at at r (t ) 

Evaluating a Positive integer power 
If an expression is raised to a power less than 20, the Evaluate command will 
rewrite it as a product. 

x4 xxxx 

Evaluating a Factorial 
The Evaluate command will compute the factorial of any integer less than 13. 

5!= 120 

6!=720 

12! =479001600 

7 
I 
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Chapter 5 Rewriting Expressions 

Evaluating a Absolute Value 
The Evaluate command will compute the determinant of a lxl or 2x2 matrix. 

l~l=x 

t ~l=ad-bc 
Evaluating a Summation or Product 
The Evaluate command will pull a term out of a sum or product. This is the same 
as the Eval Sums or Products command discussed later in this chapter. 

Evaluating a Substitution 
The Evaluate command will evaluate a substitution. (This is the same as 
~-CS)). 

t et =x2 x2ex2 

Evaluating a Eva/ Between 
The Evaluate command will rewrite the Eval Between template as a difference 
between the endpoints. 

b 
f (x)lx=a f (x)lx =b-f (x)lx =a 

Evaluating a Log 
The Evaluate command will rewrite a log of a product or power as the sum 
of logarithms. 

log (abc) 

log x" 

log a+log b+log e 

nlog x 

93 



Milo User's Guide □

94 

Evaluating a Log Base b 
If an expression is of the form I og bx , the Evaluate command will rewrite the ex- 

pression in terms of the natural log. 

log x 
b 

log x 
log b 

Evaluating a Choice function 7 
The choice function is rewritten by the Evaluate command in terms of factorials. 

(~) n! 
m!(n-m)! 

Eval Integrals 
Keyboard: ~ - [O 
Menu: Simp > Eval Integrals 
Modifier Keys: None 

The Eval Integrals command can only evaluate polynomial integrals. It rewrites 
definite integrals as indefinite integrals evaluated between the limits. To integrate 
a polynomial it is necessary to use this command several times and you can see 
the steps Milo follows in evaluating the integral. 

Applying the Eval Integrals command four times to the first expression below 
produces the other three. 

a 

Jx2+x+ldx 
o 

Jx2dx+ Jxdx+ J1dxC0 

a 

Jx2+x+ldxL=o 
a 

x3 x2 
-+-+X 
3 2 X =O 

Eval Derivatives 
Keyboard: ~ - (ID 
Menu: Simp > Evaluate Derivatives 
Modifier Keys: ~ 

The Eval Derivatives command evaluates derivatives, applying the chain rule 
when necessary in complex expressions. When evaluating partial derivatives, all 
dependencies must be explicitly written. When evaluating total derivatives, the 

I 

____j 

~_J 

__J 

r--, 

~ 
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Chapter 5 Rewriting Expressions 

Eval Derivatives command treats all atoms as if they depended on the variable of 
differentiation. This command does not evaluate nth derivatives, which must be 
expanded using the Evaluate command first. 

Œe!]- Eval Derivatives 
With the Œe!J key down, the Eval Derivatives command only evaluates the top 
level of each derivative and does not evaluate each derivative generated by 
the chain rule. 

In the examples below, the Eval Derivatives command is applied to the first 
expression to produce the second. The Œe!J Eval Derivatives command pro­ 
duces the third expression. 

a 
axabx2 ➔ 2abx ➔ a ªaxbx2+bx2aa 

ax 

d 
dxabx2 ➔ ( 

2db) 2da a 2bx+x - +bx - 
dx dx ➔ d 2 2da a-bx +bx - 

dx dx 

a 
a/an X ➔ sec 2x ➔ sec 2xax 

ax 

a xX --ex 
ax ➔

X xX ( r\ xx ex · xxOog x+Olog x+xx-lJ ➔ xXX a xX 
e -x ax 

:x(sin 2x+cos 2x) ➔ o ➔ a a t=si n 2x+-cos 2x ax ax 

a J.------ - 2 ax X -1 ➔
i._(x2-1) 

x(x2-f112 ➔ J-x2-_1( log (x2-1):x(1)+ª-2x(_x2-_1-.------~ 
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Eval Sums or Products 
Keyboard: ~- Œ) 
Menu: Simp > Eval Sums or Products 
Modifier Keys: [ SM ft ] 

The Eval Sums or Products command pulls a term out of a sum or product and 
increments the appropriate index. 

[ sMft ]- Eval Sums or Products 
If the [ s M ft ] key is held down when the Eval Sums or Products command is 
invoked and both sum or product indices are positive and their difference is less 
than 100, this command will write out all terms in the sum or product. 

In the following examples, applying Eval Sums or Products to the first expression 
creates the second expression. The third expression is the result of applying 
[SM ft ] - Eval Sums or Products. 

5 ». 
n=O 

➔
5 

ªo+ 2'.anxn 
n=l 

➔ 2 3 4 5 a0+xa1 +a2x +a3x +a4x +a5x 

~ 1 n _x_2_n +_1_ 
L..- (2n+1)! 
n=O 

➔ ¿{-l)nx2n+1 
X+ 

(2n+~! 
n=l 

3 

1f x+i 
i=O 

➔
3 

X 1f X +i 
i=l 

➔ x {x + 1) (x +2) (x +3) 

5 

1fi 
i=l 

➔
5 

1fi 
i=2 

➔ 1(2)3(4)5 

10 

~n 
n=l 

➔
10 

~n+l 
n=2 

➔ 1+2+3+4+5+6+7+8+9+10 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

7 
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Eval Substitutions 
Keyboard: (jj) - (S) 
Menu: Simp > Eval Substitutions 
Modifier Keys: None 

The Eval Substitutions command searches through the selection range and 
wherever it finds a substitution template, the substitution will be lexically 
performed and the result will automatically be simplified. 

ala=b ➔ b 

ex sin x 

X
2+1 

➔
X= 0.5 

e0.s sin 0.5 
0.52+1 

f (x)lx =b-f (x)lx =a ➔ f (b)-f (a) 

The Tfm Menu 

Rectangular 
Keyboard: None 
Menu: Tfm > Rectangular 

Cylindrical 
Keyboard: None 
Menu: Tfm > Cylindrical 

Spherical 
Keyboard: None 
Menu: Tfm > Spherical 

These commands expand the Div, Grad, and Curl operators in the appropriate 
coordinate system. The divergence and curl will be expanded only if their argu­ 
ment is a three component matrix. 
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The following are the gradient, divergence, and curl: 

E1 E1 

Vf V•IE2 Vx E2 

E3 E3 
L - 

in rectangular: 

_-] 

~1 I a a 
ax ay~-az'=z 
at a a a a a - axE1 + ay'=z + az~ azE1-ax~ ay 
at a a - ax'=z-a/1 az 

cylindrical: 

at 
ar 
1 at 
rae 
at 
az 

1 a 1 a a 
--r E +--1=z+-~ rar l rae az 

1 a a 
~ ae~ - az'=z 
a a 
azE1-a7~ 

1(ª a ) - -r Ez--E rar ae l 
_ _) 

, __ _) 



~ 

~ 
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and spherical coordinates: 

at 
ar 
1at 
rae 

1 at -- 
r sin ea<I> 

1 a 1 a 1 a 
--r2E +-- Ei_sin e+-- ~ 
r2ar l rsineae rsinea<1> 

1 (a a ) 
r sin e läe~sin e- a<I>EiJ 

1 (ª . a ) -E -s,n e- 
r Sin 0 a<I> l arr ~ 

1(a a ) ~la"? Ei_- aeE1 

The Rectangular, Cylindrical and Spherical commands will not expand the 
Laplacian template. To find the laplacian, evaluate the divergence of the gradient 
in the desired coordinate systems as follows: 

In rectangular: 

au 
ax 

v2u=V•V U=V•lªu = a au+ a au+ a au 
ay axax ayay azaz 
au 
az 
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cylindrical: 

au 
ar 
rau 1 a au 1 a iau a au V2U=V•V U=V•I-- =--r- +----+-- rae rar ar raer ae azaz 
au 
az 

and spherical: 

au 
ar 
1au v2u=V•V U=V•l;a0 

1 

1 a 2 au 1 a h a~, . 1 a 1 au 
=~a/ ar +rsin 0ae\ra0J5,n e+rsin eéM>rsin eéM> 

au· 
r sin ea<I> 

More Examples of Coordinate Systems 
Evaluating the following in rectangular coordinates and then evaluating the 
derivatives by choosing Eval Derivatives gives 

a ax{x2+y2) 
2x 

V {x2+y2) =l:y{x2+y2)j=j~y 

:z{x2+y2) 

-' 

---7 
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,:r I 

L.. 

e 
~ 

e 
e 
e 

Evaluating the laplacian of r2 in spherical and evaluating the derivates yields 6. 

a -r2 ar 
1 a 

V•v r2=V•l--r2 1=6 rae 
1 a 2 

rsinea<I>r 

This result can be checked in rectangular coordinates knowing that r2=x2+y2+z2• 

a 
-( 2 2 ~ ax X +y +Z

2J 
2x 

V• V (x2+y2+z2' =V• li__(x2+y2+z2' =V• 2yl=i._2x +~y +i..22 =6 J ay J ax ay az 
2z 

:zcx2+y2+z2) 

Long Division 
Keyboard: ~- ~ - [) 
Menu: Tfm > Long Division 
Modifier Keys: None 

The Long Division command performs polynomial long division. To use it, select 
a variable in a fraction of two polynomials. 

In each of the following lines, selecting the blackened "x" and choosing the 
Long Division command produces the next expression. 
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x2+2x+l 
X +1 

➔ lx+ 1 
X+-- 

X +1 
➔ X +1 

X2+2X+2 
X +1 ➔ lx +2 

X+-- 
X + 1 ➔ xJ-1 +1) 

\i<+ 1 

x3-a3 -a3+ax2 
( 3 2 ) X2+ 2 -a +a x .·. 2 ➔ ➔ x + ax+ ·· .. ··• ➔ x +(ax+a2) -x--a x-a x-a 

X +2 ➔ 1 -- --+1 
X+ 1 X+ 1 

Change Coordinates 
Keyboard: None 
Menu: Tfm > Change Coordinates 
Modifier Keys: None 

The Change Coordinates command changes vectors between spherical, 
rectangular, and cylindrical coordinate systems. The selection must be a lx3 or a 
3xl matrix. Choosing the Change Coordinates command brings up a dialog box 
that prompts for the transformation to apply, upon which Milo applies one of 
following four rewrite .rules. 

Rectangular to spherical: Rectangular to cylindrical: 

Jx2+y2+Z2 
xl IJx2+y2, 

Xl I YI goes to Jx2+y2 YI goes to latan ; I Î 

atan 
ZI I z z 

atan t IZ 
X 

..J 
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Spherical to rectangular: 

r r sin ecos <D 

e I in spherical goes to Ir s in e s in <P I in rectangular. 
<P r cos e 

Cylindrical to rectangular: 

r 

e I goes to Ir s in e I in rectangular. 

z 

r cos e 

z 

Trig ➔ Base Trig 
Keyboard: None 
Menu: Tfm > Trig-> Base Trig 

This command rewrites trigonometric expressions in terms of sin and cos, or sinh 
and cosh, by applying the following rewrite rules. 

sin x 
tan x ➔
tanh x 

ese x 

sech x 

cotx 

csch x 

sec x 

COS X 

sinh x ➔
cosh x 

1 - ➔
sin x 

1 - ➔ cosh x 
COS X ➔ sin x 

1 
-- ➔

sinh x 
1 ➔

COS X 
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1) coth x ➔ cosh x 
sinh x 

2 2 1 sinx 
2) COS X sec X tan X ➔ COS X---- which simplifies to sinx 

COS XCOS X 

( 
1 
)
2 ( . )2 2 2 Sin X 3)1-sec X+tan X ➔ 1- + -- uponwhichtheAdd 

COS X COS X 
Fractions command produces 

sin 2x+cos 2x-1 

cos 2x 
1-1 

Here the user has to replace sin2x + cos2 x by 1 to get 

which simplifies to O using the Simplify command. 
cos 2x 

Trig ➔ Exponential 
Keyboard: (jj)- ~- [-s-M-ft-] - Œ) 
Menu: Tfm > Trig-> Exponential 

This command rewrites selected trigonometric expressions in terms of exponen­ 
tials by applying the following rewrite rules. 

sin x 

sinh x 

COS X 

cosh x 

tan x 

➔
etX -tX -e 

2t 

➔
ex -x -e 

2 

➔
etX -tX +e 

2 

➔
ex -x +e 

2 

➔
etX -tX 

-1 -e 
etX -tX +e 
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tanh x 

sin 2x+cos 2x 
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➔ ex -x -e 
ex -x +e 

➔ (el X;~ -lXr + (elX +tXr 
-(ext_e-x~2 +(ext+e-x~2 

4 

and the Multiply Out command produces 2 (1) + 2 , which simplifies to l. 
4 

The Add Fractions command produces 

The same steps show the following identity. 

cash 2x-sinh 2x = (ex +2e-xr-(ex-2e-1: 

(ex +e-x)2 -(ex-e-x)2 
= 1 

4 

2sinxcosx ➔

! I 

etX -e-tX etX + e-tX 
2 ---- ---- , which Multiplies Out to 

2t 2 

2xt -2xt 
~ e -e 2Xt ( -2xt+l +1 dSimplifiesto e -\e , an 21 

2t 

. t{2x) -t(2x) 
Using the Trig-> Base Trig command onS In (2x) produces e -e , 
simplifying to 2 t 

e2x t_e-2x t 

2t . This demonstrates the identity 2sinxcosx = sin2x 

fil 
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Taylor Expand 
Keyboard: ~ - @ill - [ shift ] - (!) 
Menu: Tfm > Taylor Expand 

The Taylor Expand command rewrites sin, cos, and ex as an infinite series by 
applying the following rewrite rules. 

The examples below illustrate the effect of applying the Taylor Expand command 
followed by the Eval Sums or Products command, or ~ - Œ), twice or four 
times. 

sin x ➔
n=O 

00 

2 2n 
n X COS X ➔ -l (2n)! 

n=O 

➔
x3 

x-- 
6 

➔
x2 

1-- 
2 

ex ➔ ~xn 
Ln! 
n=O 

➔
x2 x3 

l+X+-+- 
2 6 

Remove Division 
Keyboard: @ill - (D 
Menu: Tfm > Remove Division 

Remove Neg Powers 
Keyboard: @ill - (D 
Menu: Tfm > Remove Neg Powers 

The Remove Division command rewrites all division operators in a selected ex­ 
pression as a multiplication of a negative power. The inverse operation, Remove 
Neg Powers, rewrites negative powers as a division by a positive power. 
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These commands undo one another (with the exception of the last example 
below), so choosing Remove Division from the Tfm menu and applying it to an 
expression in the first column will rewrite it as the second column, and choosing 
the Remove Neg Powers command on an expression in the second column will 
rewrite it as the first column. 

a 
b ➔ ab-1 

1 
b ➔ b-1 

a 
bed ➔ ab-1 c-1 d-1 

1 
ex ➔ e-lx 

e-X ➔ 9-X 

1 
Notice that Milo does not rewrite e-x as --;- simply because it is more useful in e 
mathematics to leave "e" in the numerator. 

Vectors ➔ Matrices 
Keyboard: ~ - @ill - Q) 
Menu: Tfm >Vectors-> Matrices 

The Vectors-> Matrices command rewrites atoms with the vector diacritical 
mark as lx3 column matrix. 
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....ai. 

A ➔

-3li, -3li, 

X•X ➔

A-{Bx ê)-(B-{Cx Ä)) ➔

A1 

A2 

A3 
- _J 

- 
X¡ X¡ 

X2 • X2 

X3 X3 

A1 

A21• 

A3 

---7 

Transpose Matrix 
Keyboard: ~- @ill - CT) 
Menu: Tfm > Transpose Matrix 

The Transpose Matrix command transposes a selected n-by-m matrix, rewriting it 
as an m-by-n matrix. 

a 
b 

e 
➔ ~b~ 

~~ 
➔

~~ 

1 2 

3 4 ➔ fi 3 ~ 
@4~ 
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Matrix Algebra 
Keyboard: (jj) - ŒeD - (ô) 
Menu: Tfm > Matrix Algebra 

The Matrix Algebra command performs matrix multiplication and addition and 
dot and cross products on any selected matrix. 

a1 ,-a 
-·:1 ➔ -b 

1-C - - 
- - 

a1 12ª 21bl ➔ 2b 

Cl 12c 
• _J 

:tl~I 110+01 110 
➔ 120+11 hich si ff 121 , w IC simp I res to 

301 l\fl 130+\f \f +30 

Xii IX1 

X2l• IX2 

X3I 1x3 
➔ h. h . 1·£· 2 2 2 X¡ X¡ +X2X2 +X3X3 w IC Simp I tes to X¡ +X2 +X3 

A• {Bx g, -{ß • {Cx A)) expanding these v~~tors gives 
A1 

A21• 

A3 
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choosing 'Matrix Algebra' once expands the cross product, 

::;.; ;;:~:-;:~:; ;_; ;~:;.; ;~:A:-C:A: ) ) 
A3I \ 181 C2-82 ci1 / \ 1831 \ Ic1 A2-C2A1 

~ 

simplifying and choosing 'Matrix Algebra' again produces 

(A 1 (B2 C3-B3 C2) + A2 (B3 C1 -B1 C3) + A3 (B1 C2-B2 cJ)-(s1 (A3 C2-A2 C3) + B2 (A 1 C3-A3 cJ + B3 (A2 C1 -A 1 C2)) 

and after running the Multiply Out command all the terms have canceled 
leaving O. 

I 
,__J 
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Chapter 6 Using Rules 
What this chapter contains 
The following commands are discussed in this chapter: 

• Enter Rule 
• Apply Rule 
• Create Menu Item 

This chapter offers a guide to building your own rules in Milo. Rules provide 
direct access to Milo's pattern matcher and the information that follows shows 
you how to customize the program to your specific needs. 

This is also a complete list of all the Tables of Formulas found on the Milo distri­ 
bution disk, including everything from financial formulas to astronomical quan­ 
tities. 

What is a rule 
A rule in Milo is really a transformation rule that specifies how to rewrite expres­ 
sions. Milo uses a built-in pattern matcher to interpret a rule and apply it to any 
selected expression. 

When you apply a rule to a selected expression, Milo replaces everything in the 
expression that matches the left hand side of the rule with the right hand side of 
the rule. For example, when Milo applies the rule a= b to the expression 
a3 + a2 + a, the program replaces all occurrences of "a" with "b" to produce 
b3 +b2 +b. 

Rule Syntax 
Rules are created by typing them into a Milo equation block the way you would 
enter any other expression. A rule must be in one of the following forms or any 
combination them: 
a=b 
a+-b 
a=b=c 

The letters "a" and "b" above may be arbitrary expressions. The assignment 
arrow in the second example above is produced with the colon key OJ , or in­ 
serted using the Assignment command in the More submenu of the Templates 
menu. 
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Rules also may be taken from the files in the Tables of Formulas folder on the Milo 
distribution disk. 

Rule Sets 
Rules may contain multiple assignments and may extend across multiple equation 
blocks in Milo. Any rule that has more than one assignment is called a rule set. To 
create a rule set, simply select all the individual assignment expressions. Hold 
down the @:EI) key before clicking and dragging with the mouse will select across 
multiple equation blocks. Milo ignores any text blocks that may be in between. 

Here are some examples of rule sets that can be selected together: 

sin (-x)=-sin x COS (-x) = COS X tan (-x) =-tan x 

sin x =Ji-cos 2x 

cos x = J 1-sin 2x 
The lines separating equation blocks above can be turned on and off through the 
Options command in the Edit menu (see the chapter on Other Features). 

Dummy variables 
Dummy variables are variables in a rule that take on the value of any expression. 
Dummy variables are interpreted as wild card variables by Milo's pattern 
matcher. Dummy variables are displayed on the screen in boldface notation to 
distinguish them from regular atoms. A dummy variable is created by selecting an 
atom and typing ~ - @:EI) - @) or by selecting an atom and choosing Dummy 
from the Diac menu. 

The atom "a," the Dummy variable "a," and every occurrence of "x" in the rules 

sin (-x)=-sin x 
are all a dummy variables. 

COS (-x) = COS X tan (-x) =-tan x 

~---. 
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The Enter Rule command 
Once a rule has been built, it can be entered into a buffer as the "active" rule. 
This is done using the Enter Rule command in the Rule menu, and must be done 
before a rule can be applied to an expression. Only one rule or rule set can be 
active at a time, and when a new rule or rule set is entered, the old one is erased. 

To enter a rule or rule set, select the desired expression or expressions and 
choose the Enter Rule command from the Rule menu. For example, to enter a 
rule that will replace all occurrences of the variable "x" with the variable "y," the 
setup would look like this: - Rules 

Enter Rule :~: 1 
Hpply Rule 
Create Menu Item ... 

The Apply Rule command 
Once a rule or rule set has been entered, it can be applied to another expression 
by selecting the expression or expressions that you want to rewrite, and choosing 
the Apply Rule command from the Rule menu. Milo's pattern matcher will take 
over and perform all appropriate substitutions. 

If you have a rule set in the buffer, the Apply Rule command will search from the 
top of the rule set to the bottom. As soon as it finds a match, it applies the rule. 
This means that the order of the rules in the buffer is important. The first rule 
Milo finds that fits is used. 

The Create Menu Item command 
The Create Menu Item command is a feature that keeps often-used rules at your 
fingertips. Once you have used the Create Rule command to place an active rule 
in Milo's buffer, you can store it (or a rule set) as a menu item simply by choos­ 
ing the Create Menu Item command from the Rule menu. 

A menu item may be a user-specified name or the default name, User Item A, 
User Item B etc .. 

Milo does not remember menu items or rules once you quit the program, so it is 
a good idea to keep often-used rewrite rules in a separate Milo file. Many such 
rules are kept in the folder called Tables of Formulas supplied on the Milo 
distribution disk. A list of the available files in the folder is included at the end of 
this chapter. 

]ill 
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Adding new templates 
Rules in Milo may be used as an effective way of creating new templates. New 
templates composed of existing Milo primitives may be stored in the Rule menu 
and applied easily to expressions. For example, applying the rule 

a s j a dx 
o 

to any selected expression will wrap the integral template with respect to "x" 
around the expression. 

Tables of Formulas on the Milo distribution disk 
The Milo disk contains a folder called Tables of Formulas that includes a wealth of 
information in the form of rules that may be used with the pattern matcher to 
solve all sorts of complex problems. The tables included on the disk include: 

• Astronomical Quantities 
• cgs Physical Constants 
• Cubic Equation 
• Determinants 
• Financial Formulas 
• Integral Table 
• Integrals - loop and e"x 
• Integrals - Rational Fractions 
• Integrals - Trig Functions 
• Integrals - Definite 
• SI Physical Constants 
• Units Ratchet 

These files are accessed using the Open command in the File menu, and it is worth 
taking the time to browse through them to familiarize yourself with the formulas 
available. 
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Chapter 7 Graphing Expressions 
What this chapter contains 
• How to create graphs 
• Examples of graphing techniques 

This chapter explains how to graph expressions in Milo. There are two parts to 
the chapter, the first part introduces the graphing features and outlines what you 
can do with graphs in Milo. The second part contains examples of graphing 
techniques. 

Using Milo to create graphs 
Graphs are created in Milo by selecting an expression or expressions and choos- 
ing the Graph Expression command from the Edit menu. The keyboard equiva­ 
lent for the Graph Expression command is ~ - (ID. 
Milo will graph parameterized curves and real-valued functions of one variable, 
and is able to overlay more than one graph in a window at a time. Unlike expres­ 
sions and text, graphs are built in a separate graphing window and may then be 
pasted into a Milo document through the Clipboard. 

The Graphing Dialog box 
When you select the Graph Expression command the following dialog box will 
appear on the screen: 

Title: 

H Label: 

Y Label: 

H HHis: I I to I I 
YIIHis: I Ito I I 
Domoin:I I I to I 1. I 

Number of Points: I so I 
[ Ok ) ( Concei ) 

r¡ 
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The dialog box allows you to configure the following parameters: 

Title 
You can name the graphing window by typing a string in this box. What you type 
here has no effect on the actual graphing, just on the window. The title defaults to 
empty, which means no title will be displayed for the resulting graph. 

X Label 
Name the "x" axis. Defaults to empty. 

Y Label 
Name the "y" axis. Defaults to empty. 

X Axis 
Allows you to specify the range of the "x" axis. This defaults to empty and nor­ 
mally should be left empty in which case the axis is automatically scaled to show 
all the points and use the entire graphing window. 

Y Axis 
Allows you to specify the range of the "y" axis. This defaults to empty and nor­ 
mally should be left empty in which case the axis is automatically scaled to show 
all the points and use the entire graphing window. 

Domain 
The points for the graph are generated by substituting floating point numbers 
between the starting and ending points of the domain for the variable in the 
expression to be graphed. For example, graphing the expression sinx over the 
specified range from O to 6.2, will substitute floating point numbers between O and 
6.2 for "x," and graph the result. 

Number of Points 
This parameter allows you to choose the number of points to be plotted in the 
graph. Logically, the more points you choose, the smoother the graph and the 
longer it will take to compute. In the upper left corner of the graphing window, 
the points are counted off during computation. Any integer between two and 512 
(the number of pixels on a Mac SE and Plus screen) can be used. For example, 
when graphing the expression sinx over the specified range from O to 6.2, you can 
specify the number of points to be 50 and Milo will substitute 50 floating point 
numbers between O and 6.2 to obtain the result. 

Real-valued functions of one variable 
Graphing a single expression is done by selecting the expression and choosing the 
Graph Expression command in the Edit menu. In order for Milo to graph the 
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expression, the expression must evaluate into a floating-point number. This 
_ means that only expressions with one independent variable may be graphed. 
Milo applies the Number Crunch command automatically when graphing 
expressions and constants like "e" and "re" are evaluated. 

To graph the expression 

sin tan x-tan sin x 

from -3 to 3, select the expression and pick Graph Expression from the Edit menu 
or simply type ~ - @) . 

Fill in the Graph Expression dialog box to look like this: 

Title: 

H t.atrel: 

Y t.abel: 

H RHis: I I to I I 
Y aats: I I to I J 

Domain: 1-3. I to J 3. J 

Number of Points: J 1 DO J 

[ Ok J ( Cancel ] 

and click OK. Remember that the ~ key jumps the insertion point from cell 
to cell in the dialog box, just as it cycles the insertion point from ? prompt to ? 
prompt in a new template. 

------ ¡,¡ 
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The resulting graph looks like this: 

Graph 

2.5 

1.5 

0.5 

-3. -1. 
-0.5 

-1.5 

-2.5 

~ 

~ 

~ 

~ 

~ 

-7 ~ 

~ 

Graphing parameterized curves ~ 
Milo has the ability to plot parameterized curves, where one expression represents 
the "x" value and another expression represents the "y" value for the graph. In 
other words, 

x = first expression 
y = second expression 

To graph a parameterized curve, the selected range must be two expressions on 
the same line, separated by the Next Expression template, available in the Tem­ 
plates menu or by typing the GJ key. 

Similar to graphing functions of one variable, do not use more than one inde­ 
pendent variable in both expressions. If you do, Milo will treat both variables 
as the same variable and graph the resulting expression. 

If you have "1" as the first expression and "1" as the second expression and you 
plot them as a parametric graph, Milo will plot the point (1,1). Here, no variables 
are involved. 

If you have "x" as the first expression and x2 as the second, it is the same as 
plotting the non-parametric graph of x2. 
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,:, ...... 
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If you have "l" as the first expression and the variable "t" as the second, Milo 
will graph a vertical line. Similarly, sint cost graphed between O and 21t will 
produce a circle. 

Similarly the expressions sinx and cosy will be graphed as a circle because Milo 
treats "x" and "y" as the same variable when graphing parameterized curves. 

Resizing the graphing window 
The graphing window may be resized by clicking in the lower right corner of the 
window and dragging, even though the resize icon is not visible. The icon is 
hidden to enhance the appearance of the graphing window. 

f§□~~~~~§ liraph ~~~~~§0§ 
>·················································································································································· 

3. 

1 . 

-3. -1. 
-1. 

-3. 
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Inserting graphs into a Milo document 
When the graphing window is active, you may cut it to the Clipboard to trans­ 
port it into a Milo document. It usually helps to resize the window before trans­ 
porting it. To paste a graph into a document, make sure the previous expression 
is not selected. 

Milo's graphics block 
When a graph is pasted into a Milo document, it is placed in a "graphics block." 
There are no manipulation commands available in graphics block mode, though 
the File and Edit menus are available in the menu bar. 
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Overlaying graphs 
More than one expression in Milo may be graphed simultaneously to overlay one 
graph on another. This feature is useful, for example, to observe the point or 
points where graphs intersect. 

When graphing the two expressions like tan X and 2x, the two expressions 
must appear on two separate lines in a Milo document (separated by a (return]). 
The expressions must be both in separate equation blocks and on two separate 
lines for them to be overlayed on a graph. To select both expressions at the same 
time, use the~ - Select command described below. 

The ~ - Select command 
Holding down the ~ key when selecting expressions in Milo allows you to 
select across equation and text blocks to select multiple blocks. The ~ - Select 
command ignores text blocks. 

Graphing two expressions at once 
Once you have selected both expressions, use the Graph Expression command 
from the Edit menu or type ~ - @), set the parameters you want in the Graph­ 
ing dialog box, (for the graph below, the domain was set between -10 and 10, and 
the number of points was set to 100) and click OK. Here is the graph Milo pro­ 
duces from the above set of expressions: 

·~J 

-- 

-- 

To use the~- Select command, hold down the ~key and click the mouse ~ J 
near the top expression to be graphed and drag to the bottom expression: 

- --! 
____ _J 
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6rnph E!lê 

30. 

-30. 

Zooming in on a graph 
One of the most useful features of Milo's graphing capability is the zooming 
feature. To locate maximum and minimum points as well as points of intersec­ 
tion, you can quickly and easily magnify any part of a graph. 

To use the zoom feature, you must first graph an expression or expressions. 
Take, for example the two expressions discussed above tan X and 2x. To zoom 
in on a particular part of the graph, simply draw a box around the part of the 
graph you want enlarged, by clicking and dragging with the mouse. Here is an 
example of a box that will zoom in on the intersection between the two plots: 

6rnph E!] 

30. 

-30. 
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Here is a picture of the resulting "zoomed" graph: 

Graph t!J§ 

6. 

4. 

2. 

0.8 1.2 1.6 2. 2.4 2.8 

-- -ì 
__ ! 

When you let go of the mouse, the graphing dialog box will appear again, this 
time containing values for the new graph. Do not change the values for the "x" 
and "y" axes, since those have been determined by the exact positioning of the 
zoom box. Y ou can change the number of points for Milo to plot. 

~- Zoom: bypassing the graphing dialog 
A faster way to zoom in on a graph is to bypass the graphing dialog box. This is 
especially useful when you want to zoom in many times on a graph. By holding 
down the ~ key while drawing the zoom box, and keeping it depressed when 
you let go of the mouse, you can bypass the graphing dialog box and accept the 
default values for the parameters. The value for the Number Of Points will remain 
the same as in the original graph, and the "x" and "y" coordinates and Domain 
parameters will change depending on where you draw the box. 

____ _j 
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Chapter 8 Other Features in Milo 
What this chapter contains 
This chapter contains information about Milo that doesn't belong anywhere else. 
These features are found in the Edit menu and include: 
• Keymap 
• Command Key 
• Options 
• The Style menu 
• Insert Text Block 
• Insert Equation Block 

Keymap 
The Keymap command in the Edit menu opens a window that looks like this: 

il Key Map -. 

"" o 
1 2 3 4 5 6 7 B 9 O - = qwertyui o p [ ] 

X- 1 2 3 4 5 6 7 B 9 O - = qwertyui o p o 
)( ~ xl • o x + □WERTVUI o p 

J "' )( 
~ 8 ùJ p 't' 'V 1) 8) n. 

1i J GD V ~~= ®ne n 'I' 'P \ an 

B s d f g h j k l ' z><cvbnm, I \ 

B s d f g h j k l . "str" Z)(CVbnm )( !. 
g 

A S D F G H J K L +-- Z X C V B N M < > li 
cx.cr 6 t y Tl 'K À • ~ ~ X ~xn~~ lie=, 
I >:A ~r A t} X B V _µ o 

¢1 IO [2] 

The first line in each quadrant of the Key Map window is the label on a key on 
the keyboard. The upper left quadrant represents the top row of keys, and the 
bottom right quadrant represents the bottom row of keys. The bottom right 
corner serves as an example below to illustrate how to interpret the Key Map 
window: 
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zxcvbnm, I \ - - 
z x e v b n m )( ~ 

u 
Z X C V B N M < > li 
~ ~ X ~xn~~ '-'=u 
XS V }1 

Keys exactly as displayed on 
bottom row of the Mac keyboard. 
The atom, operator or diacritical 
mark the key corresponds to in Milo. 'i 
With the [shift ] key depressed. ~ 

With the @:e!] key depressed. 

With the @:e!) and [ s M ft ) 
keys depressed. 

The second line of each quadrant shows what atom, operator or diacritical mark 
the key corresponds to in Milo. 

The third line corresponds to holding the [shift ] key down while typing 
that key. 

The fourth line corresponds to holding down the @:e!] key while typing that key. 

The last line corresponds to holding both the [shift ] and@:eü keys down while 
typing that key. 

Command Key 
The Command Key command in the Edit menu displays the following dialog box: 

Select a menu item 

The command key will supercede any 
preuious use. 

( Cancel ) 

_ _J 
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Selecting a menu item with the mouse when this box is open does not execute 
that command. Once a command has been selected, the dialog changes: 

Now, type the key for it 

The command key will supercede any 
preuious use. 

( Cancel ] 

Now typing a key like~ - Œ) will make ~ -Œ) a command-key equivalent 
for the chosen menu command. 
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Options 
This command brings up the following dialog box: 

-e- 

Options 

18] Ruto Group Sum 
[81 Ruto Group Product 
18] Ruto Order 
18] Ruto Simplify 

Floating Point Options: 

18] Strip Trailing Zeros 

18] Hierarchical Menus 
D Display Lines 
18] Enable Undo 

Significant Figures: 16 I 
Sc i enti fic Not at i on: 

Smallest Large Number: 

Largest Small Number: 

I 1 DODO. 

~ ) 
I O.ODD 1 

Auto Group Sum 
Auto Group Product 
Auto Order 
These settings affect the Simplify command and all commands which use Milo's 
simplifier. They are normally enabled. Turning off Auto Group Sum will no longer 
automatically collect terms like "x + x." Turning off Auto Group Product will no 
longer automatically collect factors like "xx." Turning off Auto Order will no 
longer automatically order terms in a product alphabetically. These commands 
may in very rare cases be useful working with non-commutative algebra. 

Auto Simplify 
Some commands, like Matrix Algebra, automatically invoke the simplifier after 
they have manipulated an expression. This option can disable the auto simplifying 
process so that more intermediate steps can be seen. 



LI 

e 
L 
L 
L 
e 
L 
L 
L 
L 
L· 
L 
L 
e 
e 
L' 
L 
L 
L 
L· 
L 
L 
e 
L 
L 
L 

Chapter 8° Other Features of Milo 

Hierarchical Menus 
The Calculus, Trig, and More menus are by default submenus of the Templates 
menu. They may, however, be displayed as top-level menus on the menu bar if 
the Hierarchical Menus option is turned off. 

Display Lines 
This option causes lines to be drawn horizontally across the screen between each 
Equation, Text and Graphics block. 

Enable Undo 
This option enables or disables the Undo feature. When working with very large 
expressions, the overhead of keeping old copies for Undo may be noticeable. 
Unless you have a specific reason, it is not recommended that this option be 
used. 

Strip Trailing Zeros 
This option controls the display of floating point numbers after the Number 
Crunch command has been executed. It causes the trailing zeros to be dropped in 
the string displaying the number. 

Significant Figures 
This option controls the number of digits shown when displaying a floating 
point number. Internal calculations are performed to 19 digits of precision. 
Numbers are rounded for display and the internal value is not saved. This means 
that after a result is displayed, no more precision is stored than was displayed. 
This was done so that results would not be ambiguous. Otherwise, with 1 
significant figure set here, 3.0 * 0.3 could be 0.9 if the numbers were as displayed, 
or it could be 0.99999 if the 0.3 were "really" 0.33333 internally. 

Smallest Large Number 
Largest Small Number 
These settings control when to use scientific notation. Numbers smaller than the 
largest small and larger than the smallest large number will be automatically 
displayed in scientific notation. 
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The Style Menu 
When in text mode, Milo displays a Style menu to provide flexible text input: 

li File Edit Font 
✓Plain TeHt agp 
Bold 88B 
/111/ir. 881 
Underline aBU 
Cilmll□Drnril 
~[bt!JC!]C!J[!g 

~ 
000 

✓Oi 

º'° om 
i&O 

and the adjacent Font menu offers the choice of fonts installed in the system 
currently in use. 

Insert Text Block 
This command, in the Edit menu, creates a new text block below the current block. 
If the insertion point is in an equation, this is accomplishes the same thing as 
typing the [enter] key. 

Insert Equation Block 
This command, in the Edit menu, creates a new equation block below the current 
block. If the insertion point is in an equation block, this accomplishes the same 
thing as typing a [return]. If the insertion point is in a text block, this is the same 
as typing the [ enter] key. 
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Chapter 9 Tips and Techniques 

Chapter 9 Tips and Techniques 
What this chapter contains 
Tips are included to help you use Milo effectively in the following areas: 

• Quick reference to atoms, templates and rewrite commands 
• Fonts 
• Selecting expressions 
• Menus 
• Mouse clicks 
• Moving terms around in an expression 
• Duplicating expressions 
• Floating point numbers, strings and integers 
• Special keys 
• Keyboard equivalents 
• The Command Key option 
• The backslash.ini file 
• Defining rules 
• Graphing 

The Tips and Techniques chapter is the place to be if you already consider 
yourself somewhat of an expert with the Macintosh. This chapter will help you 
optimize your use of the program. 

Quick reference: Atoms 
Here is a list of often-used atoms and the fastest way to insert them in a Milo 
document: 

a Alpha @D-@ 
Li Delta @!) - [ shift ] - @) 
e (the constant) Œ) 
00 Infinity @!) - (shift] - (ID 
1t Pi @D-® 
Note that typing ( Sh; ft ] - Œ) after and integer or a floating point number 
applies the Scientific Notation template to that number (see the Input Reference 
chapter). 
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Quick reference: Templates 

li Absolute Value OJ 
i+-? Assignment CD 
? 

Jid? Definite Integral @!]- [s·Mft ]-(D 
? 

a Dummy variable ~-@D-@ 
? ô a· Exponential 

il Factorial CD 
Jid? Indefinite Integral @D-(D 

I Matrix @!]-~ 

? i~ Next expression 0 
a? ~-m - Partial derivative ai 
? 
¿i Product @!) - [ shift ] - (ID 

?=? 

1 X 1Q? Scientific Notation [ shift l - Œ) 
Ji Square Root @D-® 

?li=? Substitution @D- CS) 
? 

Tri Summation @!) - [ shift ] - Œ) 
?=? 

d? 
~ - [ shift ] - CT) - Total derivative di 
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Quick reference: Rewrite commands 

Add Fractions ~-@ 
Distribute ~-Q) 
Distribute Over Equality ~-G 
Eval Derivatives ~- (ID 
Eval Integrals ~-(D 
Eval Substitutions ~- CS) 
Eval Sums or Products ~-Œ) 
Evaluate ~-[) 
Factor ~-Œ) 
Long Division ~-@!)-[) 
Matrix Algeria ~-@!)-~ 
Move Left @D-Q 
Move Right @ill-O 
Multiply Out ~-(yt) 
Number Crunch ~-Œ) 
Order Sum ~ - @ill - [ s M ft ] - (ID 
Remove Division @!)-(O 
Remove Neg Powers @ill-CD 
Simplify ~- Œ) 
Solve For ~-Œ) 
Taylor Expand ~ - @ill - [ sMft ]- CT) 
Transpose Matrix ~-@!)-CT) 
Vectors-> Matrices ~-@D-Q) 
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The best tip on how to use Milo effectively is to use it as a math processor. Al­ 
though Milo does have the power to manipulate expressions, its real power is in 
its interface and speed. Here are some tips on how to let you get the most out of 
the program: 

Fonts 
If you already have 9- and 12-point Symbol font installed in your system, you can 
remove those two fonts from the Milo application using Apple's Font/DA Mover 
to save space. Remember to hold down the option key when clicking on the Open 
button in the Mover program to be able to open Milo since it is an application, not 
a system resource file. 

If you want to copy and paste expressions created in Milo into a word 
processing or other application, make sure that application has access 
to 9- and 12- point Symbol font. If those fonts are not available, 
display quality will be reduced. 

Selecting expressions 
To manipulate an expression in Milo, you have to select it. The space bar, the 
mouse and the up and down arrow keys perform selecting operations: 

---\ 
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~ 
Even if no expression is previously selected, the·space bar 
will expand a selection range through each valid subexpres- 
sian until the entire expression is selected. 

[shift] ~ 
Holding down the shift key when pressing the space bar will 
de-select an already selected range, the opposite of just 
using the space bar. 

(î) Similar to the space bar, the up arrow key expands a se- 
lected range until the entire expression is selected. Part of 
the expression must be already selected. 

rn The down arrow de-selects an expression similar to the shift- 
space combination, but some part of the expression must 
already be selected. 

The left arrow key cycles the selection range counter- 

E) clockwise through an expression selecting each smallest 
valid subexpression. Some part of the expression must 
already be selected. 

(3 The right arrow key cycles the selection range clockwise 
through an expression in the same way as the left arrow key. 

@!)~ Holding down the option key when pressing the space bar 
performs the same action as the left arrow key. This was 
designed mainly for use with keyboards that do not have 
arrow keys. 

Use the mouse to select all or part of an expression by 
Mouse clicking and dragging. At all times, Milo will only let you 

select a valid expression or subexpression. 
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The space bar (!e) selects an expression starting with the smallest subexpression 
nearest the insertion point. Press the (!e) again to select the next largest subex­ 
pression. If you keep typing the space bar you will eventually select the entire ex­ 
pression. The (!) key works the same way except unlike the space bar, the (!) 
key requires some subexpression to be already selected. 

On older Mac keyboards without arrow keys, ~ - Space and @ill - Space do 
the same things as the right and left arrow keys. 

Milo will not let you select anything that is not a valid mathematical expression. 
When you type over a selected range, the range is not replaced but operated on 
by what you type. 

By clicking and dragging with the mouse, you can select any valid subexpression. 

Mouse clicks: Moving terms around in an expression 
Besides selecting expressions and subexpressions in Milo, the mouse can be used 
to move terms of an expression right or left relative to other terms. (See the 
Rewriting Expressions chapter). 

Holding down the ~ key and clicking to the left or right of a selected term in an 
expression will move the term in the expression. This is the same as using the 
Move Term Left and Move Term Right commands in the Simp menu. It does not 
distribute the term into parenthesis or other subexpressions. 

Holding down both the~ and @ill keys when clicking to the right or left of a 
selected term will move that term to the left or right and distribute it into an 
adjacent subexpression if possible. The same effect can be achieved by holding 
down the @ill key and choosing the Move Term Left or Move Term Right com­ 
mands from the Simp menu. 

Holding down the [shift] key and issuing a Move Term Left or Move Term 
Right command will move a selected term to the extreme left or right of an expres­ 
sion. This also can be done by holding down the ~ and [shift ] keys and click­ 
ing with the mouse to the right or left of a selected term. 

~ 

~ 

~ 

~ 

~~ 

'~ 

~ 

7 
__J 

~ 

_J 

--7 

~ 
~ 



L 
L 
e 
L 
L 
L' 
L 
L 
L 
L 
(.:' 

L 
L 
L 
L 
L 
L 
L 
L 
L 
L 
L' 
L 
L 
e 
L 

Chapter 9 Tips and Techniques 

Duplicating expressions 
It is a good idea to make copies of your work as you go along so you and anyone 
else can follow the steps you take to solve a problem. Before you manipulate an 
expression, select it and copy it to the clipboard with ~- (£). Then type G 
and paste it back with ~ - Œ). Perform your simplification on the right hand 
side of the equal sign. 

You can also use the Duplicate command in the edit menu that creates a new 
equation block directly below a selected expression and duplicates it into the 
new block. 

Menus 
The keyboard equivalents for some of the menu choices are displayed incor- 
rectly. This occurs when more than onecontrol key is required. For example, the 
keyboard equivalent for the Dummy template is ~-@ill- (Q). This is 
displayed in the Menus as: 

Uector o-u 
Bnr 
Hnt o-fi 
Dot 
Prime ' 
Tilde 
Sub Tilde o-- 
Sub boH o-_ 
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The keyboard equivalent for the Taylor Expand command should be 
interpreted as follows: 

~ 

~ 

~ 

~ 

Rectangular 
Cylindrical 
Spherical 

Long diuision o-L 
Change coordinates 
Trig -> base trig 
Trig -> eHponential 
, za:: ua.c::.ca _a_, 
Remoue diuision 
Remoue neg powers 
t••······························································•1 
Uectors to matrices o-J 
Transpose matriH o-t 
MatriH algebra o-m 

ag., 
Hold down the 
shift key 

•• Disregard this 
character 

88' 
88µ - 

Hold down the 
command key 

Hold down the 
option key 

With the ( shift ] , (jj) and @ill keys held down, type a Cf) to execute a Taylor 
Expand command. 

Floating point numbers, strings and integers 
Typing any number of integers followed immediately by a decimal point creates a 
string containing those integers. Typing a decimal point with no preceding 
integers creates a string starting with the number zero followed by a decimal 
point. 

Strings cannot have spaces in them. Use the underscore key Q to connect 
words together. 
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Always select a string if you want to operate on it, since it is hard to tell whether 
the insertion point is inside or outside the string. 

Special keys 

G) Next Expression 
Use the semicolon key to create more than one expression per line in an equation 
block. This is used for graphing parametric equations. 

(D Assignment Operator 
The assignment operator"+-" is produced using the colon key, or accessed 
through the More submenu of the Templates menu. 

Gill 
Use the tab key to cycle through the? prompts when filling in a template. 

Differences between the Evaluate and the Eval Sums or 
Products commands. 
The Eval Sums or Products command and the Evaluate command are not the 
same. Evaluate operates on the entire selected expression and evaluates summa­ 
tion or product operators in that expression once. Using the Evaluate command 
again will have no effect on the expression. The Eval Sums or Products com­ 
mand, on the other hand, keeps performing a substitution each time the com­ 
mand is invoked. 

Keyboard equivalents 
Keyboard equivalents are pre-defined for many Milo commands and you can 
create your own by using the "Command Key" option in the Edit menu outlined 
in this chapter. As you become better acquainted with Milo, using the keyboard 
instead of the menus will help get things done faster. 

The pre-defined keyboard equivalents in Milo, as well as the Macintosh key­ 
board equivalents, are listed across from the particular selection in the each of 
the menus. 

Command Key option 
This option, available in the Edit menu, lets you customize Milo's menus by 
adding your own command-key equivalents. Any command-key equivalent you 
create will override any existing keyboard equivalent with the same name, in­ 
cluding the standard Macintosh equivalents like ~ - (ID for Save. 

137 



Milo User's Guide ~ 

~ 

138 

Bypassing the Backslash.ini file 
This file can be bypassed on startup by holding down the caps lock key when 
opening Milo. Holding down the caps lock key tells Milo not to load the file, 
which speeds up launching the application. Without the Backslash.ini file, Milo's 
macro facility will not be available. 

Defining rules 
You can enter rules that are on more than one line in a Milo document. Use 
~ - click select across multiple lines. When you enter a rule, Milo will ignore 
any text blocks between expressions, so you can drag right over text blocks to 
enter rule sets. 

Rules are exact lexical replacements. This means that an expression must corre­ 
spond exactly to a rule or the rule will not be applied. 

Rules must be in exact order of precedence. The first rule in a rule set that Milo can 
apply, will be applied. No other rules in the rule set will be tested. 

Once you have created and inserted a menu item using the Create Menu Item 
command in the Rules menu, you cannot delete it except by exiting the program. 

Several files chock full of rules are supplied on the Milo distribution disk. See the 
chapter called Using Rules for a listing of those files. 

Graphing 
In a graphing window, straight lines may be drawn by clicking and dragging with 
the mouse. This allows you to check points on the "x" or "y" axes. 

To overlay one graph on another, put two equations in two separate 
equation blocks and use ~ - click-drag to select both lines. Then graph as you 
normally would. 

The Graphing dialog box does not clear or reset the previously-used values, but 
remembers the values last used. This means if you want to change the settings, 
you must do so by clearing each field individually. 

To insert a graph into a Milo document, cut it and paste it into the document. The 
graphing window may be resized even though the resize icon is not present. If you 
want the graph to be small, resize the window and then paste it into the Milo 
document. 
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Chapter 9 Tips and Techniques 

When zooming in on a graph, hold down the @ill key as you click and drag 
the mouse to avoid bringing up the graphing dialog box. This will tell Milo that 
you accept the default values for the graphing parameters. 

When you know a graph is linear, use only two or three points in the domain. 
This will speed up the graphing process significantly. 

Keeping more than one or two graphing windows open at once will slow Milo 
down so try to keep as few open as possible. 

When graphing, make sure you only use one independent parameter. Milo treats 
all independent parameters as the same variable. 
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absolute value 60, 93 
Add Fractions 83 
addition 55 
anticommutator 77 
Apply Rule 30, 31 
arrow keys IV 
assignment operator 29, 76 
atoms 3, 51-53 

backslash.ini file 2, 55 
backslash key IV, 2 
bra 73 
bracket 73 
bulletin board III 

calculus templates 68-73 
Change Coordinates 102 
character atoms 52 
choice function 76 
comma 71 
commutator 77 
coordinate systems 

Rectangular 97-101 
Cylindrical 97-101 
Spherical 97-101 
Change Coordinates 102 
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copy 7, 17, 24 
Command Key IV, 124, 137 
Create Menu Item 35, 113 

cross product 66 
curl 65 

D dagger 78 
delta 72 
derivative 

covariant 71 
total 68 
partial 69 
nth total 69 
nth partial 79 

diacritical marks 3, 73 
bar74 
dot74 
dummy75 
hat74 
prime 74 
sub box 75 
sub tilde 75 
tilde 75 
vector 73 

differential 72 
differential operator 72 
differentiating 23, 25 
Distribute 89 
Distribute Over Equality 91 
divergenceôf 
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E 

F 

division 56 
domain, of graph 116 
dot product 66 
dummy variable 5, 32, 112 
duplicate 17, 24, 135 

e53 
enter key IV, 2, 16 
Enter Rule 30, 31, 113 
equation mode 1, 8 
Eval Sums or Products 96, 137 
Evaluate 92, 137 
Eval Between 63, 93 
Eval Derivatives 24, 94-95 
Eval Integrals 27, 94 
Eval Substitutions 28, 97 
expectation 61 
exponentiation 14, 56 
expressions V, 14, 16-22 
expression syntax 3 

Factor 88 
factorial 59 
floating point numbers 54, 136 
fonts 128, 132 
function 77 
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gradient 65 
graphics block 1, 48, 119 
graphing expressions 26, 41-49, 115, 138 

the graphing dialog box 41-42 
the graphing window 43, 119 
graphics input 46, 120 
overlaying graphs 46, 120 
zooming in on graphs 44-45, 121-122 

greek symbols 52 

hierarchical menus 127 
hotline III 

:-] 

--7 
_ _J 

I i 81 
identity 60 
inputting text 1 
inputting expressions 2 
inserting graphics 1 
integer 53, 136 

integer arithmatic 80 
integral 

definite 27, 70 
indefinite 70 _ __j 

path 71 ~-, 

loop 71 
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ket 73 

keyboard equivalents 14, 137 
keymap 123 

laplacian 65 
limit 64 
log base b 64, 93 
Long Division 101 
lower index 67 

matrices 65 
Matrix 67 
Matrix Algebra 109 
Transpose Matrix 108 

menus in Milo 8, 135 
Milo distribution disk V 
mouse 134 
Move Left 20, 86-87 
Move Right 20, 86-87 
multiplication 57 
Multiply Out 24, 40, 82 

n-ary operators 62 
negation 56, 58 
newsletter III 
Next Expression 76, 118 
Number Crunch 34, 39-40, 85 

145 

11- li I 



Milo User's Guide 

o 

p 

R 

146 

Option 53, 126 
Option key IV 
OrderSum84 
overbar 61 

parametrized curve 47, 48, 118 
partial derivative 17, 24, 68 

partial operator 72 
pattern matcher 29 
period key IV 
pi53 
polynomials 55 
printing 5 
product 64, 93 

I 
__j 

rational function 23 
Remove Division 106 
Remove Neg Powers 106 
return key IV 
rewrite rules 4-5, 29, 111, 138 
rewriting expressions 4, 79 
rule set 34, 112 
rule tables 30, 11·4 
Rules menu 8, 30 
runtime definitions 2 
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saving Milo files 22 
scientific notation 39, 55 
scrapbook 7 
selecting expressions 2, 18, 120, 132-133 
semicolon key 77, 118, 137 
Simp menu 8, 80 
Simplify 14, 21, 80-82 
Solve For 22, 89 
space bar IV, 2, 19 
square root 58 
special keys IV, 137 
standard macros 55 
strings3, 37, 39, 54, 136 
style menu 128 
subtraction 56 
subscript 65 
substitution 38, 62, 93 
summation 63, 93 
superscript 65 
system software I 

tab key IV, 29, 52, 117, 137 
Taylor Expand 106 
text mode 1, 8, 15-16, 128 
Tfm menu 8, 97 
Transpose Matrix 108 
Trig-> Base Trig 103 
Trig-> Exponential 104 
trigonometric functions 25, 32, 41, 43, 62, 117 
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unary operators 58 
Undo 7,127 
upper index 67 

variation 72 
vector 65 
Vectors-> Matrices 107 

zooming in on a graph see graphing expressions 
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PAKACUMP PRUGH.AM LICENSE AGREEMENT 
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE OPENING THIS DISKETTE PACK­ 
AGE. OPENING THIS DISKETTE PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU 
DO NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN THE PACKAGE UNOPENED AND YOUR MONEY WILL 

BE REFUNDED. 

Paracomp, Inc. provides this program and licenses its use. 
You assume responsibility for tl'llliselection of the program to 
achieve your intended results, and for the installation, use 
and results obtained from the program. 
LICENSE You may: 
a. use the program on a single machine 
b. copy the program into any machine-readable or printed 

form for backup or modification purposes in support of 
your use of the program on the single machine. 

c. transfer the program and license to another party if the 
other party agrees to accept terms and conditions of this 
Agreement. If you transfer the program, you must at the 
same time either transfer all copies, whether in printed or 
machine-readable form, to the same party or destroy any 
copies not transferred. 

You must reproduce and include the proprietary rights 
notices on any copy. 
RESTRICTIONS YOU MAY NOT DISTRIBUTE COPIES OF 
THE PROGRAM TO OTHERS OR ELECTRONICALLY 
TRANSFER THE PROGRAM OR ACCOMPANYING DOCU­ 
MENTATION FROM ONE COMPUTER TO ANOTHER 
OVER A NETWORK. THE PROGRAM CONTAINS TRADE 
SECRETS; AND IN ORDER TO PROTECT THEM, YOU MA Y 
NOT DECOMPILE, REVERSE ENGINEER, DISASSEMBLE, 
OR OTHERWISE REDUCE THE PROGRAM TO A HUMAN­ 
PERCEIV ABLE FORM. YOU MA Y NOT MOD~FY, ADAPT, 
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR 
PROFIT, DISTRIBUTE, NETWORK OR CREATE DERIVA­ 
TIVE WORKS BASED UPON ALL OR ANY PART OF THE 
PROGRAM OR DOCUMENTATION. 
TITLE The original and any copies of the program, in whole 
or in part, including translations, compilations, partial copies, 
modifications, and updates are the property of Paracomp or 
its suppliers. You have only the limited rights granted by this 
license. You are not an owner of a copy of the program, and 
17 U.S.C. section 117 does not apply. 
TERM The license is effective until January 1, 2030. You may 
terminate it any any other time by destroying the program 
and accompanying documentation together with all copies, 
modifications and merged portions in any form. It will also 
terminate upon conditions set forth elsewhere in this 
Agreement or if you fail to comply with any term or condition 
of this Agreement. You agree upon such termination to 
destroy the program together with all copies, modifications 
and merged portions in any form. 
EXPORT You acknowledge that the laws and regulations of 
the United States restrict the export and re-export of the 
program. You agree that you will not export or re-export the 
program or media in any form without the appropriate 
United States and foreign government approval. 
RESTRICTED RIGHTS LEGEND Use, reproduction, or 
disclosure is subject to restrictions set forth in subparagraph 
(a) through (d) of the Commercial Computer Software - 
Restricted Rights clause at 52.277-19, subparagraph (c)(l)(ii) 
of the Rights in Technical Data and Computer Software clause 
at 2!?2.227-7013, and Paracomp's standard commercial 
agreement for this software. Unpublished - rights reserved 
under the copyright laws of the United States. 
GENERAL You may not sublicense, assign or transfer the 
license, program or documentation except as expressly 
provided in this Agreement. Any attempt otherwise to 
sublicense, assign or transfer any of the rights, duties or 
obligations hereunder is void. 
This Agreement will be governed by the laws of the United 
States and the State of California as applied to transactions 
taking place entirely within California between California 
residents. 
This Agreement is the complete and exclusive statement of 
the agreement between Paracomp and you, which supersedes 

any proposal, prior agreement, or other communications 
relating to the subject matter of this Agreement. No 
variations of the terms will be enforceable against paracomp 
unless Paracomp specifically agrees in writing. 
Should you have any questions concerning this Agreement, 
you may contact Paracomp by writing to'Paracomp, Inc.; 123 
Townsend, Suite 310; San Francisco, CA 94107. 

LIMITED WARRANTY 

THE PROGRAM AND DOCUMENTATION IS PROVIDED 
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MER­ 
CHANTABILITY, TITLE AND FITNESS FOR A PARTICU­ 
LAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE PROGRAM AND DOCU­ 
MENTATION IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU (AND NOT P ARACOMP OR AN 
AUTHORIZED DEALER) ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
SOME STATES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES SO THE ABOVE EXCLUSION 
MA Y NOT APPL Y TO YOU. THIS WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS AND YOU MA Y ALSO 
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO 
STATE. 
Paracomp does not warrant that the documentation or the 
functions contained in the program will meet your require­ 
ments or that the operation of the program will be 
uninterrupted or error free. 
However, Paracomp warrants the diskette(s) on which the 
program is furni shed to be free from defects in materials and 
workmanship under normal use for a period of ninety (90) 
days from the date of delivery to you as evidenced by a copy 
of your receipt. 
Paracomp's entire liability and your exclusive remedy will be: 
1. the replacement of any diskette not meeting Paracomp's 

"Limited Warranty" and which is returned to Paracomp 
with a copy of your receipt, or 

2. if Paracomp is unable to deliver ·a replacement diskette 
which is free of defects in material or workmanship, you 
may terminate this Agreement by returning the program 
and documentation to Paracomp; and your money will be 
refunded. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY PARACOMP, ITS DEALERS, DISTRIBUTORS, 
AGENTS OR EMPLOYEES WILL CREATE A WARRANTY 
OR IN ANY WA Y INCREASE THE SCOPE OF THIS 
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH 
INFORMATION OR ADVICE. 
LIMITATION OF LIABILITY IN NO EVENT WILL 
P ARACOMP OR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION OR 
DELIVERY OF THE PROGRAM OR DOCUMENTATION BE 
LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDEN­ 
TAL, INDIRECT OR SPECIAL DAMAGES, INCLUDING 
ANY LOST PROFITS OR LOST SAVINGS ARISING OUT OF 
THE USE OR INABILITY TO USE THE PROGRAM OR 
DOCUMENTATION EVEN IF PARACOMP HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOT .. 
WITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE 
OF ANY LIMITED REMEDY OR FOR ANY CLAIM BY ANY, 
OTHER PARTY. 
SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 
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